ClinicalExpress®
Administratorhandbuch

Version 6.1
fur allgemeine Radiographie
und Mammographie



© Copyright VIDAR Systems Corporation. Alle Rechte vorbehalten.

Kein Teil dieser Veroffentlichung darf ohne schriftliche Genehmigung von VIDAR Systems Corporation
reproduziert, auf einem Abrufsystem gespeichert oder in irgendeiner Form oder auf irgendeine Art und
Weise — elektronisch, mechanisch, durch Fotokopieren, Aufzeichnen oder anderweitig — iibertragen
werden.

ClinicalExpress ist eine eingetragene Marke der VIDAR Systems Corporation.

VIDAR® stellt Support gemaR den allgemeinen Geschéftsbedingungen bereit, die in der
Lizenzvereinbarung aufgefiihrt sind. Alle anderen allgemeinen Geschaftsbedingungen
stammen maglicherweise von VIDAR-Handlern. Falls diese Geschaftsbedingungen von den
VIDAR-Geschaftsbedingungen abweichen, liegt die Erfullung dieser Verpflichtungen in der
Verantwortung des Handlers und nicht in der Verantwortung von VIDAR. Des Weiteren wird
Support nur unter folgenden Voraussetzungen gewahrt:

m Die Installation und alle Modifikationen erfolgen durch qualifiziertes Personal.
m Die Gerate werden gemafR den Anweisungen in diesem Handbuch verwendet.

m  Auf der ClinicalExpress-Workstation wird keine andere Software oder Hardware verwendet
als die, die von VIDAR zugelassen ist oder von VIDAR mit ClinicalExpress geliefert wird.

365 Herndon Parkway Vertrieb: +1.800.471.SCAN oder +1.800.471.7226

I DA R Herndon, VA 20170 USA E-Mail: order@3dsystems.com

V¥ systems corporation
A 3D Systems Company

Telefon: +1.703.471.7070 Technischer Support:
Fax: +1.703.471.7665 +1.703.471.7070 oder +1.800.471.7226
Internet: www.filmdigitizer.com E-Mail: medtech@3dsystems.com

EC

Prinsessegracht 20 E-Mail:
REP 2514 AP Den Haag
Niederlande

europe@emergogroup.com

19746-001 Rev. C

ClinicalExpress 6.1 Administratorhandbuch



Inhaltsverzeichnis

VerwenNdUNQGSZWECK .....cccuueiiiiiiiiiiniieesiis s s ssssssssss s s s s s s s s s snssssssss s s s s s nnnnnsssssssssssnsnnnnnnns 5
Uber dieses Handbuch ... e 6
In diesem Handbuch verwendete Konventionen ... 6
Uber ClINICAIEXPIrESS®.......cciicieircrierrceeerssseersssssesssssessssssessssssesssssssssssessssnsesssssessssanessnns 8
L@ 0] 170] 0 1=1 o PP 8
SYSIEMUDEISICNL........oiieie e ae e ne s 9
Allgemeiner Radiographie-Modus (General Radiography Mode)...................... 10
Mammographie-Modus (Mammography Mode)..........cccoviiieniniieeee 11
Was kénnen Sie mit ClinicalExpress erledigen?...........ccooveieieniinieienenceeeen 12
Neue Funktionen in CliniCalEXPress 6.1.......cooi e 13
Installieren von CliNiCAIEXPrESS®........ccvrrcirrrreerrrieeereseessssssessssessssssessssssssssssssssnses 14
SystemManforderunNgEN.........c.ocui i s 14
(7o) 1] 10 | (=Y S 14
FIlMAIGItaliSIErer .......ooue e 14
NetzZWerkverbiNAUNG .......coccoriieee e 14
Optionaler DOKUMENISCANNET ..........ccoioiie e 15
INStallatioNSSZENANIEN ..o 15
InstallationsUbersiCht....... ..o e 16
A. Den Filmdigitalisierer installieren und konfigurieren ............ccccceecevvveniecenenene. 16
B. Die Anzeige einStellen ............coiioioiiii e 17
C. Die ClinicalExpress-Software installieren ..............cccoeeoeeeveeiieecceecieecee e 19
Hinzufligen eines Flachbett-Papierscanners ............ccocovveeeeceececciece e 19
D. CliNiCalEXPress StarteN ...........cocieciieciice ettt n 20
E. ClinicalExpress-Lizenzschllissel anfordern .............cccocevevieiiesecceeceeceeveee 21
Konfigurieren von CliniCalEXPress®........cccviirrvriisniesnsesssessssssssss s sssssssssssesssssssssnns 25
01 0] 0 o SRS 25
Anmelden im Fenster Administration ... 26
Einstellen von Parametern auf der lokalen Workstation............cccocoeeveveieniieecne 27
DICOM-Parameter..........coeeoiieieeeeiese ettt st sttt st eenes 28
o (0] (0] (o | S S 28
LOKAISIEIUNG ...ttt et e eneeneeneenneens 29
SYSIEIM. e bt b e ae st ene e 29
Autom. Abmeldung (AUt LOGOUL)........coeiiiiiiirieeces e e 32
Nach dem Senden l6schen (Delete After Send).........cocoeoeveiiniiieienencceee 32
Nach der Speicherubernahme I16schen (Delete After Storage Commitment) ...33
Standardmanige Start-GUI...........coccooiiiriieienee e 33
Autom. Ausflllen Untersuchung (Auto Fill Study).........cccceveieneniiniceieneceeee 33
Einstellen von Anzeigeparametern...... ..o 34
Einstellen von DigitalisiereraufloSungen.............ccccveveeieienieieerese e 37
Einstellen von Bildbearbeitungsoptionen .............cccceveiieiiesieseeseeeeeee e 38
Definieren von Mammaographie-AnsiChten............ccccevieiiiieccecce e 41
Erlduterung der Ansichten und Patientenausrichtungen.............ccccccveveeieennene. 43
Erstellen von benutzerdefinierten Codes und benutzerdefinierten
ANsichtsMOdIfiZIErer-COAESs.........ooiiiiirieeeeeeese e 44
Zuweisen obligatorischer Dateneingabefelder ..o 47
Verwalten von Benutzerkonten............coooi oo 48

19746-001 Rev. C ClinicalExpress 6.1 Administratorhandbuch



Auswahlen von Datenfeldern fir die ANONymisierung..........ccccceeeveeeeeeneeneseeenes 51
Sichern und Wiederherstellen der Lizenz .............ccooiiiiinineieneneeeeeeee 53
DefiNieren VON ZIEIEN .........c.ooiiiiieceeee e e 55
Erstellen €iNes NEUEN ZIEIS...........coeiiiiiiiiiiieee e 56
Verwalten von Zielinformationen .............oceeveeieeiiecn e 65
Uberpriifen der KOMMUNIKAHON .............c.oveuiueveeeeeeceeeeeeceeeeeesesee e saese s 66
Uberpriifen der Konfiguration des FilmdigitaliSierers...............cccoevveeeurerecerverecnennes 66
Uberpriifen der Verfugbarkeit von ,Modalitét-Arbeitsliste* (Modality Work List).....67
Uberpriifen und Verwalten der Protokolldatei .................ccoceweeeceeeeeeeeceeeeeeeeeeeeens 68
Kalibrieren des FilmdigitaliSierers ... 69
Kalibrieren Inrer ANZEIGE.........ooouei e 70
Kalibrieren mit dem SMPTE-TESIMUSEEN ........cccoooviirieeeseeee e 7
Kalibrieren mit dem TG18-QG-Testmuster..........ccccoeeeeieienencceee e 72
........................................................................................................... 74

19746-001 Rev. C

ClinicalExpress 6.1 Administratorhandbuch



Verwendungszweck

ClinicalExpress ist fiir die Weiterleitung eines DICOM-Bildes von einem
medizinischen Bilddigitalisierer an einen DICOM-Druckklassenprovider oder einen
Speicherklassenprovider bestimmt. Die Zielgruppe besteht aus Benutzern, die einen
medizinischen Filmdigitalisierer verwenden mochten, um analoge oder durchléssige
Filme mithilfe eines herkémmlichen Teleradiologie-Ansatzes an eine DICOM-
Workstation zu scannen, sowie Benutzern, die Filmausdrucke mithilfe von
Digitaltechnologie in DICOM- und Postscript-Protokollen duplizieren mochten.
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Uber dieses Handbuch 6

Uber dieses Handbuch

Dieses Handbuch enthélt schrittweise Anweisungen fiir die Installation und
Verwendung von ClinicalExpress®. Das Handbuch ist in die folgenden Themen
untergliedert:

m Uber ClinicalExpress beschreibt ClinicalExpress als Teil eines typischen
DICOM-Radiographie- oder Mammographiesystems.

m Installieren von ClinicalExpress erldutert die Systemanforderungen und
enthélt Anweisungen zum Installieren der Software.

Hinweis: Verbindungsinformationen entnehmen Sie bitte dem
separaten Dokument DICOM-Konformitatserklarung (DICOM
Conformance Statement).

m Konfigurieren von ClinicalExpress demonstriert das Konfigurieren des
ClinicalExpress-Systems zur Filmaufzeichnung- und -libertragung und
erldutert andere Themen, die fiir Verwalter von ClinicalExpress-Systemen
von Interesse sein konnten.

Hinweis: Die Bedienungsanleitung ist in einem separaten
Handbuch, dem ClinicalExpress-Bedienungshandbuch, enthalten.

In diesem Handbuch verwendete Konventionen

m Spezielle Tasten, die Sie auf der Tastatur driicken, werden in KAPITALCHEN
dargestellt. Beispiel: Wenn Sie das Wort EINGABE im Text lesen, driicken Sie
auf die entsprechende Taste auf Ihrer Tastatur.

m  Meniinamen und Meniibefehle erscheinen in Blockbuchstaben. Beispiel:
Das Menii Datei (File) enthdlt den Befehl Lizenz installieren (Install License).
Befehle werden in diesem Handbuch als Kiirzel ausgedriickt. Beispiel: Datei >
Beenden (File > Exit) bedeutet: Wihlen Sie den Befehl Beenden (Exit) im
Menii Datei (File).
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Uber dieses Handbuch 7

m Fenster, Schaltflichen, Dialogfelder und andere Bildschirmfunktionen werden in
Fettschrift gekennzeichnet. Beispiel: Das Fenster ClinicalExpress-Anmeldung
(ClinicalExpress Login) (unten) enthilt die Felder Benutzername (User Name)
und Passwort (Password) sowie die Schaltflichen OK und Abbrechen (Cancel).

Clinical Express Login

Uger Mames: j

Password: |

] Cancel |
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Uber ClinicalExpress®

ClinicalExpress 6.0 ist ein Windows-basiertes Programm, das Filme digitalisiert und
Filmbilder tibertrdgt. Das Programm enthilt die Modi ,,Allgemeine Radiographie*
(General Radiography) und ,,Mammographie* (Mammography) und kann nur fiir
den Modus ,,Allgemeine Radiographie®, nur fiir den Modus ,,Mammographie* oder
fiir beide Modi erworben werden.

Digitalisierung. ClinicalExpress zeigt mithilfe eines VIDAR-Filmdigitalisierers als
Eingabegerit Filmbilder an und weist sie einem Patienten und einer Untersuchung
zu. Das Programm enthilt eine Reihe von Funktionen zur Uberpriifung der Qualitiit
eines Bildes und zum Anpassen seiner Eigenschaften.

Indikationen. Radiologiebilder, die mit ClinicalExpress digitalisiert wurden, erfiillen
oder tibertreffen die ACR- und DICOM-Standards fiir die Verwendung sekundérer
Bilder zur Konsultation, Uberpriifung und endgiiltigen Auswertung.

Mammographiebilder, die mit ClinicalExpress als DICOM MG digitalisiert wurden,
dienen lediglich der Verwendung zu Referenz- oder Vergleichszwecken und sind
nicht fiir die primédre Diagnosestellung bestimmt.

Optionen
Die folgenden Optionen kdnnen separat erworben werden:

Modalitat-Arbeitsliste (Modality Work List). Mit dieser Option kdnnen
Bildmodalitéten Arbeitslisteninformationen iiber geplante Verfahren und relevante
Daten herunterladen und diese Informationen dem Modalitéts-Operator vorlegen
und sicherstellen, dass DICOM-Bilder iibereinstimmende, deskriptive Daten
enthalten. Anleitungen zur Verwendung der Modalitét-Arbeitsliste in ClinicalExpress
sind in diesem Handbuch zu finden. Integrationsdetails sind in der DICOM-
Konformititserkldrung (DICOM Conformance Statement) zu finden.

PDI. Diese Option enthélt Funktionen fiir das Importieren/Exportieren von
DICOM-Medien (zum Lesen und Beschreiben von DICOM-CDs), das Flachbett-
Scannen und die Patientenabfrage (zum Suchen nach Patienteninformationen auf
Speichergeriten).
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Uber ClinicalExpress 9

Systemubersicht

Eine typische ClinicalExpress-Workstation fiir die Filmaufzeichnung und
-libertragung besteht aus den folgenden Komponenten:

m VIDAR-Filmdigitalisierer fiir die Erstellung von Digitalbildern von Filmen.

m Windows® XP 32-Bit- oder Windows 7 32- oder 64-Bit-Computer, auf
dem das ClinicalExpress-Programm ausgefiihrt wird.

Hinweise

m Die ClinicalExpress-Workstation ist KEINE diagnostische
Workstation. Fur diagnostische Aufgaben verwenden Sie
bitte eine entsprechende Workstation (fiir Anweisungen
siehe das Installations- und Bedienungshandbuch der
diagnostischen Workstation).

m Mammographiebilder, die mit ClinicalExpress digitalisiert
wurden, dienen lediglich der Verwendung zu Referenz-
oder Vergleichszwecken und sind nicht fir die primare
Diagnosestellung bestimmt.
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Uber ClinicalExpress 10

Filmoriginal

Typische ClinicalExpress-Workstation

Allgemeiner Radiographie-Modus (General Radiography Mode)

Fiir die Bildiibertragung gibt die Workstation Bilddaten an eine Datenverbindung
aus, die diese an eine Remote-Workstation oder ein Remote-System liefert. Zum
Kopieren stellt die Workstation eine Verbindung mit einem Filmdrucker oder Nicht-
Film-Ausgabegerit her. Ein optionaler Dokumentscanner kann als zusétzliches

Eingabegerit fungieren.

Remote-
Workstation

PC, auf
dem Clinical

Express lauft

— Druckerdaten

QK-Station

B

Filmdrucker

¥

Filmkopie
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Uber ClinicalExpress 11

Mammographie-Modus (Mammography Mode)

Fiir die Bildiibertragung gibt die Workstation Bilddaten an eine Datenverbindung
aus, die diese an eine Remote-Workstation oder ein Remote-System liefert.
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Uber ClinicalExpress 12

Was konnen Sie mit ClinicalExpress erledigen?

ClinicalExpress 6.0 ist Ihre primére Steuerstelle fiir die Aufzeichnung, Ubertragung
und das Kopieren von Filmen. Sie konnen mit dem Programm die folgenden
Aufgaben erledigen:

m Digitalisieren

Designieren eines Patienten und einer Untersuchung oder Erstellen eines
neuen Patientendatensatzes und/oder einer neuen Untersuchung.
Verwenden der Option ,,Modalitét-Arbeitsliste” (Modality Work List)
(separat erhiltlich), um Patienteninformationen aus einer externen Quelle
heranzuziehen (anstatt Patientendaten einzutippen).

Grundlegende Digitalisierungsparameter einstellen: Bit-Tiefe und Auflsung.
Einen oder mehrere Filme digitalisieren.

Die Qualitét des Bildes tiberpriifen, das anhand des Films erstellt wurde,
bevor es gesendet oder kopiert wird.

Das Bild bearbeiten: Fenster und Ebene festlegen, drehen, umkehren,
Tonwerte invertieren, Bild unterteilen, einen Betrachtungsbereich
vergroBBern, zoomen und vertrauliche Informationen maskieren.

m Ubertragen

Eine Remote-Workstation oder ein Remote-System (,,Ziel*) auswahlen.
Digitalisierte Bilder an das ausgewéhlte Ziel senden.
In einem Vorgang digitalisieren und senden.

m Kopieren (nur Allgemeiner Radiographie-Modus)

Einen Drucker auswihlen (wenn mehrere Drucker mit dem System
verbunden sind).

Anzahl Kopien einstellen, die von jedem Film-Original angefertigt werden
sollen.

Druck initiieren.

Mehrere Bilder auf einem Film kombinieren.

In einem Vorgang digitalisieren und drucken.

m Von und zu DICOM-Standard-CDs importieren bzw. exportieren.

ClinicalExpress wird auf Feature-/Funktionsbasis lizenziert. Alle Lizenzen
enthalten die Digitalisierungsfunktion sowie die Funktion ,,DICOM senden*
(Senden an DICOM-Serviceklassen-Provider, Workstations/PACS) und
,Kopieren* (Drucken auf DICOM-Druckern und/oder Postscript-Geréten).
AuBerdem konnen Sie folgende Lizenzen erwerben:

m  Modalitit-Arbeitsliste (Modality Work List).

m PDI. CD-Brennen vom DICOM-Viewer zu Medienexport, Medienimport/-
export, Patientenabfrage und Papierdokument-Scanner.
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Uber ClinicalExpress 13

Neue Funktionen in ClinicalExpress 6.1

m Neue Datumsformat-Optionen.

m DICOM-Support fiir Mammographie-abgeleitete/primére Tags fiir
Kompatibilitit mit GE-Systemen.

m Support fiir Mammographie-Datumserfassung fiir Kompatibilitdt mit
Siemens-Systemen.
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Installieren von ClinicalExpress®

Systemanforderungen

Zum Digitalisieren und Ubertragen von Bildern mit ClinicalExpress® bendtigen
Sie ein Computersystem, einen VIDAR-Filmdigitalisierer und eine
Netzwerkverbindung.

Computer

Mindestanforderungen an das Computersystem fiir Windows XP 32-Bit SP3:

m 3,0 GHz Pentium 4 PC

m 2 GB Speicher; fiir groBe Séitze mit hochauflésenden Bildern wie
Mammographie ist mehr Speicher erforderlich

m 50 GB freier Speicherplatz auf der Festplatte

Mindestanforderungen an das Computersystem fiir Windows 7 Professional

32-Bit und 64-Bit:

m Dual Core 2 1,8 GHz PC

m 4 GB Speicher; fiir groBe Séitze mit hochauflésenden Bildern wie
Mammographie ist mehr Speicher erforderlich

m 50 GB freier Speicherplatz auf der Festplatte

Grafik fiir alle Computer:

m Grafikkarte mit 16 MB Speicher, eingestellt auf eine Auflésung von
1280x1024 und 64.000 Farben oder hohere Farbtiefe

m 20-Zoll-Bildschirm mit einer Auflésung von 1280x1024

Filmdigitalisierer
ClinicalExpress funktioniert mit den meisten VIDAR-Digitalisierern fiir

medizinische Filme. Wenden Sie sich an Medtech (medtech@3dsystems.com),
um in Erfahrung zu bringen, ob Thr Digitalisierer kompatibel ist.

ClinicalExpress funktioniert nicht mit Filmdigitalisierern anderer Hersteller.

Netzwerkverbindung

Geeignete Netzwerkverbindungen sind u. a. LAN, WAN, drahtlos und eine Reihe
von telefonbasierten Services. Fiir den ordnungsgeméBen Betrieb ist TCP/IP
erforderlich. Netzwerkverbindungsdetails sind nicht in diesem Handbuch enthalten.
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Installieren von ClinicalExpress 15

Optionaler Dokumentscanner

Sie kdnnen einen USB-Dokumentscanner zu Ihrem System hinzufiigen.
ClinicalExpress funktioniert mit den meisten TWAIN-Treiber. Die Moglichkeit der
Verwendung eines Dokumentscanners ist eine kaufliche Option. Eine Liste der
getesteten Scanner erhalten Sie vom technischen Support von VIDAR (siehe unten).

Installationsszenarien

Lesen Sie die Szenarien unten, um Ihren aktuellen Status zu bestimmen und zu
entscheiden, wie Sie die ClinicalExpress 6.0-Installation durchfiihren werden.

m  Wenn Sie ClinicalExpress zum ersten Mal installieren:
1. Fiihren Sie die Datei ClinicalExpress6.x..exe auf der ClinicalExpress CD aus.

2. Die Software kann 30 Tage lang in einem Evaluierungsmodus verwendet
werden. Um die Software nach Ablauf der 30 Tage weiterhin zu benutzen,
benotigen Sie einen Lizenzschliissel (siehe ,,Einen ClinicalExpress-
Lizenzschliissel anfordern® spéter in diesem Kapitel).

m  Wenn eine friihere Version von ClinicalExpress installiert ist:

e Bei installierten Versionen 4.x und frither wenden Sie sich fiir Upgrade-
Anweisungen bitte an den technischen Support von VIDAR (siehe unten).

e Bei installierten Versionen 5.0 und spiter konnen Sie ClinicalExpress 6.0
installieren, ohne die vorhergehende Version deinstallieren zu miissen.

Bei Fragen Uber die Installation der ClinicalExpress-Software
wenden Sie sich bitte an den technischen Support von VIDAR:

Telefon: +1.800.471.SCAN (+1.800.471.7226)
+1.703.471.7070 auBBerhalb der USA
E-Mail: medtech@3dsystems.com

19746-001 Rev. C ClinicalExpress 6.1 Administratorhandbuch



Installieren von ClinicalExpress 16

Installationsuibersicht

Hinweis: Sie missen als Administrator angemeldet sein,

um ClinicalExpress installieren und administrative Funktionen

durchfihren zu kénnen. Benutzer konnen, aber missen nicht,

administrative Rechte auf dem PC.Fur Anweisungen siehe:

m Thema ,Hinzufligen eines Mitglieds zu einer Gruppe* (To add
a member to a group) in der Windows XP Hilfe und im Support
Center.

m Themen ,Erstellen eines neuen Benutzerkontos® (Create a
new user account) und ,Modifizieren eines Benutzerkontos*
(Modify a user account) in der Hilfedatei fiir das Fenster
~Windows Computer Management".

Die Installation besteht aus fiinf allgemeinen Schritten:
A. Den Filmdigitalisierer installieren und konfigurieren.
B. Die Anzeige einstellen.

C. Die ClinicalExpress-Software installieren.

D. ClinicalExpress starten.

E. ClinicalExpress-Lizenzschliissel anfordern.

Einzelheiten sind in den nachfolgenden Abschnitten zu finden.

Tipp: Wenn Sie eine neue Workstation einrichten, installieren Sie
nicht alle Komponenten gleichzeitig. Installieren Sie zuerst den
Filmdigitalisierer (gemaR Anleitung, die mit dem Digitalisierer
geliefert wurde). Richten Sie als nachstes die Anzeige ein (Schritt
B). Installieren Sie zum Schluss die ClinicalExpress-Software
(Schritt C) und stellen Sie sicher, dass das System funktioniert.

A. Den Filmdigitalisierer installieren und konfigurieren

Installieren und konfigurieren Sie den Filmdigitalisierer und dessen Software
gemil Anleitung, die mit dem Digitalisierer geliefert wurde (Details sind in
diesem Handbuch nicht enthalten).

Hinweis: Sie kdnnen die Installations- und Betriebshandbucher
fur den VIDAR-Filmdigitalisierer im Kundendienstbereich auf
www.filmdigitizer.com herunterladen. Sie kénnen auch die
Nummer +1.800.471.7226 (+1.703.471.7070 auRerhalb der USA)
anrufen, um Handbticher anzufordern.
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Installieren von ClinicalExpress 17

B. Die Anzeige einstellen

1. Klicken Sie mit der rechten Maustaste auf dem Desktop, und klicken Sie dann
im Popup-Menii auf Eigenschaften (Properties).

Arrange [cons By ¥
Refresh

Paste Shorkcut

Properties

Hinweis: Der Befehl Eigenschaften (Properties) kann auf lhrem
System durch einen Anzeigeadapter-spezifischen Befehl ersetzt
sein. Klicken Sie in diesem Fall auf den Befehl. Das Dialogfeld
mit den Anzeigeeigenschaften kann anders aussehen, aber das
Ziel ist gleich, Einstellen der Anzeigeauflésung auf 1280x1024
oder héher und Einstellen der Farbtiefe auf 16-Bit oder héher

2. Klicken Sie im Fenster Anzeigeeigenschaften (Display Properties) auf die
Registerkarte Einstellungen (Settings).

Display Properties

TthBSlDesktnp Screen Saver | Appearance | Settings

A theme iz a background plus a =et of sounds. iconz, and other elements
to help you perzonalize your computer with one click.

g (o]

Theme:

by Current Theme [Modified)

Sample:

118 H Cancel ]
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Installieren von ClinicalExpress 18

3. Setzen Sie Bildschirmbereich (Screen Area) oder Bildschirmaufléosung (Screen
Resolution) auf 1280x1024 oder hoher, und setzen Sie Farben (Colors) oder
Farbqualitét (Color Quality) auf Hohe Farbe (16 bit) (High Color (16 Bit) oder

hoher.

Display Properties

Themes | Desktop | Screen Saver | Appearance | Settings |

Dizplay:

SynchMaster 21 4T[.&ne?n MNvIDIA GeForceZ MX!M?

Screen rezolution Color quality

Les | More ighest (32 bi

4

1600 by 1200 pixels

[Iroubleshnnl... ] [ Advanced ]

[ 0K H Cancel ]

4. Klicken Sie auf OK.
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Installieren von ClinicalExpress 19

C. Die ClinicalExpress-Software installieren

Hinweis: Wenn Sie von ClinicalExpress 4.x oder einer friiheren
Version aus aktualisieren, bitten Sie den technischen Support von
VIDAR (medtech@3dsystems.com) um entsprechende
Anweisungen.

Hinweis: Sie kdnnen ClinicalExpress ohne den Filmdigitalisierer
im System installieren. ClinicalExpress funktioniert jedoch nur
dann, wenn der Filmdigitalisierer am Computer angeschlossen
und eingeschaltet ist und mit dem Computer kommuniziert.

1. Legen Sie die ClinicalExpress-CD in das CD-Laufwerk des Computers ein.

2. Navigieren Sie in Windows Explorer zum CD-Laufwerk und doppelklicken
Sie auf ClinicalExpress6.x..exe.

3. Befolgen Sie die Anweisungen des Installationsprogramms.

Wihrend der Installation werden Sie aufgefordert, die Standard-GUI —
Allgemeine Radiographie oder Mammographie — auszuwihlen, die beim
Starten von ClinicalExpress angezeigt wird. Wahlen Sie die GUI, die am
besten fiir [hre Situation geeignet ist (diese Option kann auf der Seite
Administration > Lokal (Administration > Local) von ClinicalExpress
gedndert werden).

4. Nachdem die Installation abgeschlossen ist, nehmen Sie die CD-ROM aus
dem CD-ROM-Laufwerk. (In Schritt E bendtigen Sie den CD-Schliissel vom
CD-Etikett.)

Hinzuflugen eines Flachbett-Papierscanners

Sie konnen einen Flachbett-Scanner fiir die Verwendung mit ClinicalExpress
installieren. Befolgen Sie die Installationsanweisungen des Scanner-Herstellers.
VIDAR hat typische USB 2.0-Scanner mit TWAIN-Treibern getestet und ihre
Kompatibilitdt mit ClinicalExpress bestétigt.

Hinweis: Auf der ClinicalExpress-Workstation sollte nur der
TWAIN-Treiber des Flachbett-Scanners installiert werden. Alle
anderen TWAIN-Treiber konnen den Betrieb von ClinicalExpress
storen. Eine Liste der getesteten Scanner erhalten Sie vom
technischen Support von VIDAR (medtech@3dsystems.com).
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D. ClinicalExpress starten

Hinweis: ClinicalExpress funktioniert 30 Tage lang ohne
Lizenzschlissel. Um ClinicalExpress nach diesem Zeitraum
weiterhin zu verwenden, wenden Sie sich an die VIDAR
Systems Corporation, um einen Lizenzschlissel anzufordern
(Anweisungen sind dem nachsten Abschnitt zu entnehmen).

1. Doppelklicken Sie auf das ClinicalExpress-Symbol auf dem Desktop.

oder Ex’
Start > Alle Programme > ClinicalExpress (Start > All Programs > ClinicalExpress
ClinicalExpress). 6.0

2. Das Fenster Benutzeranmeldung (User Login) erscheint:

Clinical Express Login

Uger Mames: j

Password: |

] Cancel |

3. Verwenden Sie den/das Standard-Administrator-Namen/-Passwort
a. Belassen Sie den Benutzernamen (User Name) als Admin.
b. Lassen Sie das Feld Passwort (Password) leer.
c¢. Klicken Sie auf OK.

4. Wenn der Digitalisierer eingeschaltet und korrekt angeschlossen ist, erscheint
die nachfolgende Meldung. Klicken Sie auf OK.

ClinicalExpress x|

& The productis running in evaluation mode. There are 30 days
/.-' remaining. Contact VIDAR at https:/fesales. vidar.com to get a
= valid license.

oK |

5. ClinicalExpress wird gestartet.

Hinweis: Sie kdnnen erst dann Filme digitalisieren, wenn Sie
mindestens ein gultiges Ziel definiert haben. Siehe das nachste
Kapitel ,,Konfigurieren von ClinicalExpress* in diesem Handbuch.
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E. ClinicalExpress-Lizenzschlissel anfordern

Hinweis: Um einen Lizenzschllssel zu erhalten, reicht es nicht
aus, die ClinicalExpress-Lizenzvereinbarung per Fax einzusenden.
Sie mussen den Anweisungen in diesem Abschnitt folgen, um den
Lizenzschlussel per E-Mail anzufordern.

So erhalten Sie einen Lizenzschliissel:

1. Senden Sie die Referenzcode-Datei an VIDAR:

Hinweis: Sie kdbnnen nur dann einen Referenzcode generieren,
wenn der ClinicalExpress-Computer an einen VIDAR-
Filmdigitalisierer angeschlossen ist.

a. Gehen Sie im ClinicalExpress-Hauptfenster zu Datei > Referenzcode
generieren (File > Generate Reference Code).

b. Im Dialogfeld Referenzcode generieren (Generate Reference Code):
m  Geben Sie die Informationen fiir Benutzername (User Name),
Firma (Company) und Land (Country) ein bzw. dndern Sie diese
Informationen.
m  Geben Sie den CD-Schliissel vom Etikett der ClinicalExpress-
Installations-CD ein.

Generate Reference Code x|

Lser Mame: I

Company: I

Country: I

CD Key: I

Generate Reference Code

Please enter the required information and dick the Generate Reference Code button to
generate the Reference Code.

Save apy Tio Clipbeard Close
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c. Klicken Sie auf die Schaltfliche Referenzcode generieren (Generate

Reference Code).
x|
User Name: I <yOUr USEr Name =
Company: I <yOUF COMPany name >
Country: I <your country =
CD Key: I::cd key >

| Generate Reference Code I

Reference Code has been successfully generated.

Please select Copy to Clipboard and follow instructions at htips: {/esales. vidar. com for
immediate online licensing or Save the Reference Code to a file and then email the file

to mailto:medtech@vidar.com to get a license key.
Note: The Reference code is valid only for 14 days.

Save | Copy To Clipboard | Close

Hinweis: Der Referenzcode ist 15 Tage lang gliltig.

. Klicken sie auf Speichern (Save), um den Referenzcode als Datei auf der

lokalen Festplatte zu speichern. Speichern Sie die Datei an einer Stelle, den
Sie sich leicht merken kdnnen.

. Klicken Sie auf die Schaltfliche SchlieSen (Close).

Starten Sie eine neue E-Mail-Nachricht.

. Geben Sie im Adressfeld medtech@3dsystems.com ein.

. Anschlieflend:

m Suchen Sie die Datei (sie weist die Dateinamenserweiterung .ref auf),
die Sie in Schritt D oben gespeichert haben, und fiigen Sie sie an die
Nachricht an.

Senden Sie die Nachricht.

Hinweis: Wahrend Sie auf lhren Lizenzschlissel warten,
kénnen Sie ClinicalExpress bis zu 30 Tage lang ohne Schlissel
im Evaluierungsmodus verwenden. Im Evaluierungsmodus
stehen alle Funktionen zur Verfugung.
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2. Nachdem Sie Ihren Lizenzschliissel per E-Mail von VIDAR erhalten haben:

a. Speichern Sie die Anlage (mit der Erweiterung .key) auf dem Desktop.

b. Melden Sie sich als Administrator bei ClinicalExpress an.

c. Gehen Sie im ClinicalExpress-Hauptfenster zu Datei > Lizenz installieren

(File > Install License).

Install License il

| Paste From Clipboard I Load From File

Reference Code:

=

-
4 »

Register

d. Im Dialogfeld Lizenz installieren (Install License)

m Klicken Sie auf die Schaltfliche Von Datei laden (Load From File),
und 6ffnen Sie die Lizenzschliissel-Datei (mit der Erweiterung .key).

Install License il

Paste From Clipboard | | Load From File

Reference Code:

Z6rWRrghPPTS0I34QT fag6WrJbm1JCSj0 /Sg6UBDB 1sTkpg /SkRmlvBeizl

Register

<LicKey> <Date>5/30/2011 2:37:12 PM</Date>» <ID:=ad8b 1ct9-f2€:|

-
| | »

e. Klicken Sie auf die Schaltfliche Registrieren (Register).
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f. Wenn der Lizenzschliissel akzeptiert wird, erscheint das unten dargestellte
Fenster. Klicken Sie auf OK.

ClinicalExpress x|

Please relaunch your application for the features with the new
l . license to take effect completely.

General Radiology
Print
Send

g. Datei > Beenden (File > Exit).

h. Starten Sie ClinicalExpress erneut, indem Sie auf dem ClinicalExpress-
Symbol auf dem Desktop doppelklicken.

i. Zur Uberprifung Ihrer Lizenz gehen Sie zu: Hilfe > Uber (Help > About).
Ihre Lizenz erscheint oben auf der Seite. Wenn Sie Lizenzen fiir Allgemeine
Radiographie und Mammographie besitzen, sollten Sie die Lizenz in beiden
Anwendungen {iberpriifen.

. Zum Konfigurieren des Programms siehe das nichste Kapitel ,,Konfigurieren

von ClinicalExpress® in diesem Handbuch.

oder
Wenn Sie ClinicalExpress zum Drucken konfigurieren miissen, lesen Sie bitte
die Anweisungen zum Einrichten von Druckern, die fiir die Verwendung mit
ClinicalExpress validiert wurden, im Verzeichnis Druckerspezifisch (Printer
Specific) auf der ClinicalExpress-Installations-CD.
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Konfigurieren von
ClinicalExpress®

Dieses Kapitel beschreibt die administrativen Aufgaben, die innerhalb von
ClinicalExpress durchgefiihrt werden konnen.

m Anmelden im Fenster Administration

m FEinstellen von Parametern auf der lokalen Workstation
m Finstellen von Anzeigeparametern

m FEinstellen der Digitalisiererauflosung

m Einstellen von Bildbearbeitungsoptionen

m Definieren von Mammographie-Ansichten

m Zuweisen obligatorischer Dateneingabefelder

m Verwalten von Benutzerkonten

m  Auswihlen von Datenfeldern fiir die Anonymisierung
m Sichern und Wiederherstellen der Lizenz

m Definieren von Zielen

m Uberpriifen der Konfiguration des Filmdigitalisierers
m Uberpriifen der Verfiigbarkeit der ,,Modalitiit-Arbeitsliste* (Modality Work List)
m Uberpriifen und Verwalten der Protokolldatei

m Kalibrieren des Filmdigitalisierers

Dieses Kapitel enthélt auBerdem grundlegende Anleitungen zum Kalibrieren
eines Workstation-Bildschirms.

Wenn Sie ClinicalExpress erstmalig einrichten, sollten Sie zunéchst alle
Abschnitte dieses Kapitels lesen und alle Aufgaben ausfiihren, die auf Ihre
lizenzierten ClinicalExpress-Funktionen und die Systemkonfiguration zutreffen.

Hinweis: Sie missen als Administrator des lokalen Computers
angemeldet sein, um das ClinicalExpress-Fenster Administration
aufrufen und darin Anderungen vornehmen zu kdnnen.

Hinweis: Sie kdnnen erst dann Filme digitalisieren, wenn Sie
mindestens ein giiltiges Ziel definiert haben. Siehe ,Definieren
von Zielen“ spater in diesem Kapitel.
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Anmelden im Fenster Administration

Das ClinicalExpress-Fenster Administration ist passwortgeschiitzt.
1. Optionen > Administration (Options > Administration).

Wenn Sie bereits als Administrator bei ClinicalExpress angemeldet sind,
sehen Sie das Fenster Administration und konnen mit Schritt 2 fortfahren.
Andernfalls sehen Sie das Anmeldefenster:

Clinical Express Login Tipp: Der standardmafige

Name ist Admin (Grof3- und

User Name: | = Kleinschreibung beachten) und
das Standardpasswort ist kein
Password: | Passwort (d.h. lassen Sie das

Feld Passwortt frei).
0K Cancel |

2. Geben Sie das Administrator-Passwort ein und klicken Sie auf OK.
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Einstellen von Parametern auf der lokalen Workstation

# EI L!:u::

- Filr

al

- Dizplay Settings
- Diigitizer Settings
- Image Proceszing
- Mammography
- Mandatory Fields
i User M anager
- Anonyrmize
L License Backup
- Targets

Digitizer

Legen Sie Parameter fiir die lokale Workstation unter Lokal (Local) der
Baumstruktur Administration fest.

Gy Administration __

— DICOM Parameters

[ Enable Additional Patient's History

[ Auto Generate Accession Number

Station Mame: |EIinicaIE HpIEss
AE Title: IEIinicaIEHpress
Port Mumber: IED?
M anufacturer Model M arme: I‘Jidal Digitizer
—Log Localization
Log Level: W Language: IEninsh[US] j
Keep Log Entries Im day(s] | | Date Format;
— System
Minimum Disk Space; |1 0o MEB
b awimurn Filrn Length: 7 iriches
Transmizzion Retries: !':'
Retry Time: i3U miriLike(z)
Lists' Start Field: | Patient Name ]
Images Path: iE:\F'rngramDalaWidar\EIinicaIEHpress\Data'\Images J
[ Lock Keys [~ Send Empty Accession Mumber [ Setlmage Type as

[~ Send Film Size 1D

" Send each Image as a Series

DERIVEDAFRIMARY

—1 Auto Logout

Time: |E' hown(z)

r— Default Startup GLI

% General Fadiography

I'-'_ minutelz]

) Mammography

— Delete After Send
[~ Patient

—duto Fill Study

™ Images [ Date

™ Time

" Patient

— Delete After Storage Commitment

[ Images

Spply |

Cloze
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DICOM-Parameter
DICOM Parameters
Station Mame: |E|inica|E:<press
AE Title: |EIinicaIE:<press
Port Mumber: |2EIT-"
Manufacturer Model Mame: |\,|'ida[ Digitizer

Der AE-Titel (Application Entity) ist der Name, den andere Software-Anwendungen
benutzen, um diese Anwendung zu identifizieren.

1. Geben Sie den AE-Titel fiir dieses DICOM-Gerit ein (standardmiBig wird
,ClinicalExpress in dieses Feld eingegeben). Bei der Eingabe des AE-Titels
ist die GroB-/Kleinschreibung zu beachten.

2. Geben Sie die Port-Nummer (Port Number) fiir dieses DICOM-Gerit ein
(standardméBig wird ,,207° in dieses Feld eingegeben).

3. Klicken Sie auf die Schaltfliche Anwenden (Apply).

Protokoll
Log
Log Level |INFORMATION -
Keep Log Entries |1D j dayls]

1. So dndern Sie bei Bedarf die Protokolleinstellungen:

m Protokollebene: Gibt die Arten der Informationen an, die im Fenster
Fehlerprotokoll (Error Log) angezeigt werden kdnnen:
e INFORMATIONEN (INFORMATION) zeigt DICOM-Informationen
und ClinicalExpress-Informationen an.
o WARNUNG (WARNING) zeigt nur Fehler und Warnhinweise an.
e FEHLER (ERROR) zeigt nur Fehler an.

ClinicalExpress erfasst automatisch alle Fehler und Informationen. (Zum
Anzeigen des gesamten Fehlerprotokolls 6ffnen Sie die Datei clx.log in
einem Texteditor.)

Hinweis: Das Fenster Fehlerprotokoll (Error Log) ist kein
komplettes DICOM-Diagnose-Tool, da es keine vollstandigen
DICOM-Ubertragungen erfasst. Es dient hauptséachlich zur
Software-Fehlerbehebung.

19746-001 Rev. C

ClinicalExpress 6.1 Administratorhandbuch



Konfigurieren von ClinicalExpress 29

= Protokolleintrige bewahren: Eintrage in der Protokolldatei werden nach
dieser Anzahl Tagen geldscht. (Siehe ,,Uberpriifen und Verwalten der
Protokolldatei‘ spater in diesem Kapitel.)

2. Klicken Sie auf die Schaltfliche Anwenden (Apply).

Lokalisierung
Localization
Language: IEninsh[US] ﬂ
Date Farmat: | MM/DDAYYY [Defaul] =]

1. Wihlen Sie die Sprache (Language), die in der Benutzeroberfldche der
Anwendung verwendet werden soll.

2. Wihlen Sie das Datumsformat (Date Format), das in der Anwendung
verwendet werden soll.

3. Klicken Sie auf die Schaltfliche Apply (Anwenden).

4 Beenden Sie ClinicalExpress und starten Sie die Anwendung neu, um die
Anderungen zu iibernehmen.

System
— Swstem
Minimum Disk Space: |1 on MEB
Maximurn Film Length: I1 7 inches
Tranzmizszion Fetries: IU
Retry Time: |3U miriLte(]
Lists' Start Field: | Patient Name =i
Images Path: Il::'\F'mglamDataWidal\EIinicaIE:-tpress\Data\lmages _I
[ Lock Keps [ Send Empty Accession Mumber [~ Setlmage Type as
DERIMEDAPRIMARY
[ Enable Additional Patient's History [ Send Film Size ID
[ Auto Generate Sccession Mumber [~ Send each Image az a Senies

1. Andern Sie bei Bedarf die Einstellungen (Standardeinstellungen sind oben
dargestellt):

m  Mindestens erforderlicher Speicherplatz (Minimum Disk Space): Wenn der

freie Festplattenspeicher unter diesen Wert sinkt, 16scht ClinicalExpress
automatisch Dateien, beginnend mit den &ltesten Untersuchungen, die
erfolgreich gesendet wurden. Wenn das Programm nicht genug Speicherplatz
freimachen kann, um den Wert Mindestens erforderlicher Speicherplatz
(Minimum Disk Space) zu erreichen, kann der Benutzer erst dann weitere
Filme digitalisieren, wenn ausreichend Speicherplatz verfiigbar ist.
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m Maximale Filmléinge (Maximum Film Length): Dieser Wert ist

normalerweise auf eine Filmlédnge von 17 Zoll eingestellt, kann jedoch
gedndert werden, um ldngeren Filmen gerecht zu werden.

Hinweis: Erhohen Sie den Wert Maximale Filmlange (Maximum
Film Length) nur dann auf einen groReren Wert als 17 Zoll, wenn
ein DIAGNOSTICPRO® Plus oder DIAGNOSTICPRO® Advantage
Filmdigitalisierer angeschlossen ist. Informationen Gber das
Digitalisieren von Filmen, die langer sind als 17 Zoll, finden Sie im
entsprechenden Bedienungshandbuch fir den Filmdigitalisierer.

Hinweis: Das das System eine Routine mit automatischer
GroRenerkennung verwendet, um die Filmlange zu bestimmen,
kénnen perforierte Filme moglicherweise nicht digitalisiert werden.

m Ubertragungsversuche (Transmission Retries): Legt fest, wie oft

ClinicalExpress versucht, eine Untersuchung an ein Ziel zu senden.
ClinicalExpress geht mit nicht erfolgreich iibertragenen Untersuchungen
wie folgt um:

e Wenn sich andere Untersuchungen in der Ubertragungswarteschlage
befinden, wird eine nicht erfolgreich gesendete Untersuchung an
das Ende der Warteschlange gestellt und unter Beriicksichtigung der
Ubertragungswiederholungen und Wiederholungszeit (siehe unten)
ein Versuch unternommen, die Untersuchung spéter zu senden.

e Wenn sich keine anderen Untersuchungen in der Ubertragungswarteschlage
befinden, versucht ClinicalExpress unter Berticksichtigung der
Ubertragungswiederholungen und Wiederholungszeit (siehe unten) sofort,
die Untersuchung erneut zu senden.

e Wenn die Untersuchung nach einer bestimmten Anzahl
Ubertragungsversuche nicht gesendet werden kann, wird sie im Fenster
Aufgenommene Untersuchungen (Acquired Studies) (Ansicht >
Aufgenommene Untersuchungen) (View > Acquired Studies)
aufgelistet, wo Sie die Ubertragung manuell einleiten konnen.

e Eine Untersuchung, die nicht gesendet werden konnte, behilt so lange
den Status ,,fehlgeschlagen®, bis sie erfolgreich gesendet wurde.

Wiederholungszeit (Retry Time): Legt fest, wie lange (in Minuten)
ClinicalExpress wartet, bis eine Untersuchung an ein Ziel gesendet wird,
wenn der vorherige Versuch fehlgeschlagen ist.

Listenstartfeld (Lists’ Start Field): Legt fest, ob Patientenname
(Patient Name) oder ID die erste Spalte in der Liste ,,Aufgenommene
Untersuchungen (Acquired Studies) und ,,Arbeitslistenverfahren*
(Work List Procedures) bildet.

Bildpfad (Images Path): Andern Sie auf Wunsch das standardmiBige
lokale Verzeichnis fiir die Bildspeicherung. Dies kann z. B. dann niitzlich
sein, wenn Sie Bilder auf einem Laufwerk oder einer Partition mit mehr
Speicherplatz speichern mochten. Um den Pfad zu dndern, klicken Sie auf
die Schaltflache ... und wahlen Sie einen neuen Pfad aus.
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PationtS1edy/Series Information

Fatient Information
[

Study Infomation

o

[0 _oooooon:

Accasrion Numbar

Adminng Diagrosis Descigten:

Descipton

Piadpering Poyrician
Lot Mo

I Procedus Code
Cexde Ve

Last Mama: Finst Mo

[
MM OO T WM MM 55

Miosbabty.

Ittt Ny

Madge e

Dty Sebumne Desmpiater Cade Mearing

Tastensperre (Lock Keys): Wenn diese Funktion aktiviert ist, deaktiviert
ClinicalExpress Tasten (z. B. ALT-TAB), die es einem Benutzer erlauben
wiirden, zwischen ClinicalExpress und anderen ge6ffneten Programmen
hin und her zu wechseln.

Zusitzliche Patientenanamnese aktivieren (Enable Additional Patient’s
History): Wenn diese Funktion aktiviert ist, zeigt ClinicalExpress das Feld
Zusitzliche Patientenanamnese (Additional Patient History) unten im
Fenster Untersuchungsinformationen (Study Information) an.

Fatseni Inloimaslion.
[T
MM DD VY S -

T e 3] T VA e

[

Mt Ko Laat Mama: Firnt Mo it Mo MM DD VY S

Sevins Informalion: Study Inlimation Serins Inomation
DiatesTime DatedTime: Diste T
n: MM DD Y MM MM 5§ 0 MM DD YYFT HH MM 55 Medably o MM DD YAV HH MM 55
i [a [ ) 4y [ I =] | Ao [
Dok Pt {camarast furezme Wb Ittt e Bocky Part Enrent
Frotznsd barr Subttrs Doagrarn Deseresen Frotzesd barr
Drescrihion: Desorencr, Dreserpiion
Pedcemand Pctccel Cods Petemrg Prysican Petomed Potecol Cods
Cid Vi Latt Mama Fst M ek N Cada Ve
Codng Schome Detgralor Dy 5cheser Desirten
Proeedun Code r

Code Viaksn Desigrance Cerde Mearw
T Conde Mearws

Cocdng Sohama | =

0 | e |

Cade Maaring

Adtrad Pt Wttty

% | e |

Das Fenster Patienten-/Untersuchungs-/
Serieninformationen (Patient/Study/Series Information) ohne
Zusatzliche Patientenanamnese (Additional Patient History)

Das Fenster Patienten-/Untersuchungs-/
Serieninformationen (Patient/Study/Series Information) mit
Zusatzliche Patientenanamnese (Additional Patient History)

Aufnahmenummer automatisch generieren (Auto Generate Accession
Number): Wenn diese Funktion aktiviert ist, fligt ClinicalExpress
automatisch die néchste sequenzielle Aufnahmenummer im Feld
Untersuchungsinformationen (Study Information) ein, wenn der
Benutzer eine neue Untersuchung initiiert. Die eingegebene
Aufnahmenummer kann bearbeitet werden.

Aufnahmenummer leer senden (Send Empty Accession Number):
Wenn diese Funktion aktiviert ist, sendet ClinicalExpress keine
Aufnahmenummern an Ziele.

FilmgroBen-ID senden (Send Film Size ID): Wenn diese Funktion
aktiviert ist, sendet ClinicalExpress Filmabmessungen an die Ziele.

Jedes Bild als Serie senden (Send each image as a Series): Wenn diese
Funktion aktiviert ist, wird jedes Bild als Serie gesendet. Wenn diese
Funktion deaktiviert ist, kann eine Serie aus mehreren Bildern bestehen.

Bildtyp als ABGELEITET/PRIMAR festlegen (Set Image Type as
DERIVED\PRIMARY): Wenn diese Funktion aktiviert ist, wird jedes Bild
fiir die Verwendung in GE-Mammographiesystemen gekennzeichnet.

2. Klicken Sie auf die Schaltfliche Anwenden (Apply).
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Autom. Abmeldung (Auto Logout)

™ Auto Logout

Time: hiour(z) l_ mirte(z)

Wenn diese Funktion aktiviert ist, wird ClinicalExpress automatisch geschlossen,
wenn innerhalb einer festgelegten Zeit keine Benutzeraktivitét (Tastatur oder
Maus) festgestellt wird.

Klicken Sie nach dem Andern auf die Schaltfliche Anwenden (Apply).

Nach dem Senden lI6schen (Delete After Send)

Delete After Send

™ Patient ™ Images

Wenn diese Funktion aktiviert ist, 16scht ClinicalExpress Patienten und/oder
Bilder ca. 10 Minuten nach der erfolgreichen Ubertragung an das Ziel.
Uberlegungen:

m  Wenn die Funktion aktiviert ist, wird verhindert, dass die Festplatte der
Workstation bis zur Kapazitét mit Bilddateien gefiillt wird. Untersuchungen,
die direkt nach der Aufnahme gesendet und dann geléscht werden, werden
jedoch nicht im Fenster Aufgenommene Untersuchungen (Acquired
Studies) aufgelistet und konnen daher nicht zu einem spiteren Zeitpunkt an
dieselben oder andere Ziele gesendet werden.

m  Wenn die Funktion deaktiviert ist, konnen Untersuchungen im Fenster
Aufgenommene Untersuchungen (Acquired Studies) aufgelistet und zu
einem spéteren Zeitpunkt an andere Ziele gesendet werden. Jedoch werden
sich die Untersuchungen auf der Festplatte der Workstation anhdufen und
letztendlich deren Kapazitit erschopfen.

m Die ClinicalExpress-Datenbank ist auf 10 GB begrenzt. Wenn dieses Limit
erreicht ist, miissen Sie Bilder und Patienten 16schen, um weiter Filme
digitalisieren zu konnen.

Klicken Sie nach dem Andern auf die Schaltfliche Anwenden (Apply).
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Nach der Speicheriibernahme l6schen (Delete After Storage
Commitment)

Drelete After Storage Commitment

™ Patient ™ Images

Wenn diese Funktion aktiviert ist, 16scht ClinicalExpress Patienten und/oder
Bilder erst nach Eingang einer Speicheriibernahme-Meldung von einem Ziel.
Die Meldung bestitigt, dass Patienten und/oder Bilder nicht nur vom Ziel
empfangen, sondern auch gespeichert wurden. (Fiir weitere Informationen siehe
,Nach dem Senden 16schen® (Delete After Send) oben.)

Klicken Sie nach dem Andern auf die Schaltfliche Anwenden (Apply).

StandardmaRige Start-GUI
Default Startup GLI

f+ General Radiography " Mammography

Diese Option legt die Modusanzeige fest, wenn ClinicalExpress gestartet wird.
Wenn Lizenzen fiir Allgemeine Radiographie und Mammographie erworben
wurden, konnen Benutzer zwischen den Modi hin und her wechseln.

Klicken Sie nach dem Andern auf die Schaltfliche Anwenden (Apply).

Autom. Ausfiillen Untersuchung (Auto Fill Study)
Auto Fill Study

[ Date [ Time

Wenn diese Funktion aktiviert ist, wird automatisch das aktuelle Datum und/oder
die Uhrzeit in eine neue Untersuchung eingegeben.

Klicken Sie nach dem Andern auf die Schaltfliche Anwenden (Apply).
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Einstellen von Anzeigeparametern

Legen Sie Anzeigeparameter unter Lokal | Anzeigeeinstellungen
(Local | Display Settings) in der Baumstruktur Administration fest.

%
B Local
-» B Display Settings
- Digitizer Settings Drizplay zettings automatically apply window and level adiustments to animage bazed
- - Image Processing on modality and body part zelected by the uzer.
& Mammography
i Mandatary Fields — Create, Edit and Delate Display Settings
i Usger Manager 2 =
T Modality | Body Part Wiew
; i License Backup
Targets
- Filrn Drigitizer
Kl | 2
Film Type | Digitizer Type | 2 Bit | 12 Bit | 16 Bit | |
ear Film Ay Digitizer 174,155 2800, 2495 44810, 39929
ear Film TeleRadPRO 218,100 3500, 1600 56013, 25606
ear Film TeleRadFRO Edge 218,100 3500, 1600 56013, 25606
ear Film YETRadFRO Edge 218,100 3500, 1600 56013, 25606
e Film Ay Digitizer 125, 221 2000, 3550 32007, 56813
& Film TeleRadPRO 199,125 3200, 2000 51212, 32007
& Film TeleRadFRO Edge 199,125 3200, 2000 51212, 32007
& Film YETRadPRO Edge 199,125 3200, 2000 51212, 32007
Kl |+
Mew E dit Delete
™ Enable Auto window/Level

Anzeigeeinstellungen voreinstellen

Mit den Anzeigeeinstellungen werden automatisch die Fenster- und
Ebeneneinstellungen fiir ein Bild basierend auf dem vom Benutzer ausgewéhlten
Korperteil und der Modalitét angewendet. Die Einstellungen basieren auf Filmtyp,
Digitalisierertyp und Bit-Tiefe. Der Bildschirm oben zeigt vier voreingestellte
Anzeigeeinstellungen. In diesem Bereich des Fensters Administration konnen
Sie Anzeigeeinstellungen definieren, &ndern und I6schen.
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m S0 erstellen Sie eine neue Anzeigeeinstellung:
a. Klicken Sie auf die Schaltfliche Neu (New).

b. Klicken Sie im Feld Modalitit (Modality) und geben Sie dann die
Modalitit ein,
oder
wihlen Sie eine vorhandene Modalitit aus der Liste aus.

c. Klicken Sie im Feld Ansicht (View) und geben Sie die Ansicht ein.
oder
Wihlen Sie eine vorhandene Ansicht aus der List aus.

d. Geben Sie Fenster- und Ebenendaten fiir eine Bit-Tiefe ein. ClinicalExpress
berechnet automatisch die entsprechenden Werte fiir die zwei anderen Bit-

Tiefen und fiillt sie ein.

Create, Edit and Delete Display Settings

b adality Body Fart Wigw 3 Bit 12 Bit 16 Bit

DEFALLT DEFALLT DEFALLT 174,155 2800, 2495 44310, 33929
4095, 2047 ERA3 7E7

Fenster J |- Ebene

Film Type | Digitizer Type | 2 Bit | 12 Bit | 16 Bit
Clear Film Any Digitizer 174,155 2800, 24935 44810, 39329
Clear Film TeleRad PRO Digiziter 218,100 3500, 1600 BE013, 25606
F@Mﬁm Ay Digitizer 25, 22 3 32007, 56813
Blue Film TeleRad PRO Digiziter 193,125 3200, pood 51212, 32007

Fenster Ebene

e. Klicken Sie auf Speichern (Save).

Hinweis: ClinicalExpress hat voreingestellte Fenster-

und Ebeneneinstellungen fur Korperteil (Body Part) =
STANDARDEINSTELLUNG und Modalitéat (Modality) =
STANDARDEINSTELLUNG. Diese Einstellungen werden
anfanglich auf die Bilder angewendet. Der Benutzer kann

die Einstellungen mit dem uber die Maus gesteuerten Fenster-
Ebenen-Tool, durch Eingabe von Werten in die Felder
Fenster (Window) und Ebene (Level) oder durch Verwendung
der voreingestellten Fenster-/Ebenenwerte abandern. Der
Administrator kann die Standardeinstellungen (links aufgelistet)
wie nachfolgend beschrieben andern.
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m So andern Sie die Fenster- und Ebenenwerte fir eine vorhandene
Anzeigeneinstellung:

a. Klicken Sie auf die Zeile, die Sie dndern mochten.

b. Klicken Sie auf die Schaltfliche Bearbeiten (Edit).

c. Bearbeiten Sie Fensterdaten (linkes Feld) und/oder Ebenendaten (rechtes
Feld) fiir eine Bit-Tiefe. ClinicalExpress berechnet automatisch die

entsprechenden Werte fiir die zwei anderen Bit-Tiefen und fiillt sie ein.

d. Klicken Sie auf Speichern (Save).

m So l6schen Sie eine vorhandene Anzeigeeinstellung:
a. Klicken Sie auf die Zeile, die Sie 16schen mochten.
b. Klicken Sie auf die Schaltfliche Loschen (Delete).
m S0 wenden Sie automatisch Fenster- und Ebeneneinstellungen basierend auf

FilmgroRe und Bildauflosung an: Aktivieren Sie die Funktion Autom.
Fenster/Ebene aktivieren (Enable Auto Window/Level)
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Einstellen von Digitalisiererauflosungen

Legen Sie Digitalisiererauflosungen unter Lokal | Digitalisierereinstellungen
(Local | Digitizer Settings) in der Baumstruktur Administration fest.

Cx Administration > ] x|

=] Local
i b Dizplay Settings

i bl U 01z Eietl.in:z: Default rezolution settings automatically identifies the film width and sets the resolution for digitization based on the

i Image Processing nearest film size of the film width,
M h
ammograpl_l,l — Set default resalution for different DICOM standard Film Sizes
- Mandatory Fields
- User Manager DICOM Standard Film Size | Resolution
i T O BE A e
i License Backup 1012, 10" 14", 24Cmx24Cm, 24Cm=30Cm 150

- Targets 11147, 1717 150

- Filrn Drigitizer A3 150

14147, 147 150
4 { &
Change Eaticel

Digitalisierereinstellungen legen automatisch die Bildauflosung basierend auf der
Filmbreite fest.

m So andern Sie eine Auflésung:

. Klicken Sie auf die Zeile mit der FilmgroBe, die Sie &ndern mdchten.

IS

o

. Doppelklicken Sie in der Spalte Auflésung (Resolution) dieser Zeile.
c. Wihlen Sie die gewiinschte Auflosung.

d. Klicken Sie auf Speichern (Save).
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Einstellen von Bildbearbeitungsoptionen

Legen Sie Bearbeitungsoptionen unter Lokal | Bildbearbeitungsoptionen
(Local | Image Processing) in der Baumstruktur Administration fest.

Cx Administration ] x|

[=l- Local
i Dizplay Settings
& Digitizer Settings 1 Unsharp Mask
--*; jinege Fio when activated ClinicalE xpress applies the unsharp mask algarithm to sharpen image

- Mammography detall
i Mandatary Fields
i User Manager 1 Loy = Wedium  High
i Anohyrmize
i License Backup 1 DREC [Dynamic Range Compression

- Targets wihen activated ClinicalE xpress applies a nonlinear filter to compress ah imaage's dynamic

- Filrn Drigitizer range.

® Low  Meditm  High

— Pozt-Digitization Proceszing

[ Straighten Image &fter Digitization

Enter a threshald value.

2 Bitz Per Pixel: |3 Reset |
12 Bits Per Pixel: IED

16 Bits Per Pixel: a0a

1 Monitor LUT

Wwhen activated ClinicalEsprezs applies the Look Up T able values to the image before
dizplaying on the maonitar

% From File I _‘
¢ Generate using I—
Density (0.2-26)  1°
1 Apply SDF

Wwihen activated ClinicalExpress applies the Standard Display Function values to the image
before dizplaying on the maonitor

llurnination: |2[|U“ cdd m”2 Ditdin: IIJ Heset |
Ambient Light; 10 cd/ m™2 (0] P |255

Spply |

Hinweis: Standardeinstellungen im Fenster Bildbearbeitung
(Image Processing) sind aus, d. h. nicht aktiviert.
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Hinweis: Sobald ein Bild vom Digitalisierer aufgenommen wird
(d. h. bevor es angezeigt oder gesendet wird), wendet
ClinicalExpress die aktivierten Bildbearbeitungsvorgange
automatisch und permanent auf jedes Bild an. Der Benutzer
kann die Ergebnisse der Bildbearbeitung nicht riickgangig
machen. Wenn Bilder keine Bearbeitung bendtigt hatten, muss
der Administrator die Aktivierung der Optionen auf der Seite
Bildbearbeitung (Image Processing) entfernen, dann muss
der Benutzer die Filme neu digitalisieren, um neue Bilder zu
generieren.

1. Bei Bedarf Bildbearbeitungsoptionen einstellen:

m Unscharfe Maske (Unsharp Mask): Wenn diese Funktion aktiviert ist,

wendet ClinicalExpress den Algorithmus fiir unscharfe Masken an, um das
Bild zu schirfen. Wihlen Sie Niedrig (Low), Mittel (Medium) oder Hoch

(High), um das AusmaB der Scharfstellung zu regulieren.

m DRC (Dynamische Bereichskompression) (Dynamic Range Compression):

Wenn diese Funktion aktiviert ist, wendet ClinicalExpress einen nicht-linearen
Filter an, um den dynamischen Bereich eines Bildes zu komprimieren. Wiahlen
Sie Niedrig (Low), Mittel (Medium) oder Hoch (High), um das Ausmal} der

Komprimierung zu regulieren.

m Bearbeitung nach der Digitalisierung (Post-Digitization Processing):

e Bildbegradigung nach der Digitalisierung (Straighten Image After

Digitization): Wenn diese Funktion aktiviert ist, werden Bilder, die den

Schwellenwert (Threshold Value) iibersteigen, automatisch nach der

Aufnahme begradigt. Wenn diese Funktion deaktiviert ist, kann der
Benutzer Bilder im Fenster ,,ClinicalExpress* begradigen.

o Schwellenwert (Threshold Value): Das Bild muss um mehr als diesen Wert

gedreht sein, um sich fiir die automatische Begradigung zu qualifizieren.
e Zuriicksetzen (Reset): Klicken Sie, um die Standard-Schwellenwerte

wiederherzustellen.

Hinweis: Bei der automatischen Bildbegradigung wird davon
ausgegangen, dass die Filmkanten gerade sind und rechte
Winkel aufweisen. Entfernen Sie die Aktivierung dieser Option,
wenn Filme geschnitten wurden.

m Monitor LUT: Wenn diese Funktion aktiviert ist, wendet ClinicalExpress

LUT- (Look Up Table)-Werte auf das Bild an, bevor es angezeigt wird.
e Von Datei (From File): Wahlen Sie diese Option, wenn die

Referenztabelle (Look Up Table) als Datei verfiigbar ist. Geben Sie den
Pfad und den Dateinamen ein, oder klicken Sie auf die Schaltfliche zum

Durchsuchen, um die Datei zuzuweisen.

e Mithilfe von Dichte generieren (Generate Using Density): Wiahlen Sie
diese Option, wenn ClinicalExpress eine Referenztabelle basierend auf

dem angegebenen Dichtewert generieren soll.
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standard-DiIcom-sDF-werte ™ SDF anwenden (Apply SDF): Wenn diese Funktion aktiviert ist,

Beleuchtung 2000 cd/m? wendet ClinicalExpress mithilfe der festgelegten Werte fiir Beleuchtung

Umgebungslicht 10 od/m? (Illumination), Umgebungslicht (Ambient Light), Mindestdichte des

DMin 0 Digitalisierers (DMin) und Héchstdichte des Digitalisierers (DMax)

DMax 255 standardmaBige Anzeigefunktionswerte auf das Bild an, bevor es angezeigt

wird.

2. Klicken Sie auf die Schaltfliche Anwenden (Apply).
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Definieren von Mammographie-Ansichten

Ansichten liefern dem ClinicalExpress-Benutzer hdngende Protokolle zum
Zusammenfiigen separater Mammographiebilder zu zusammengesetzten Bildern.
ClinicalExpress wird mit einem Standard-2x2-Protokoll geliefert. Bei Bedarf

konnen Sie andere Ansichten definieren.

Hinweis: ClinicalExpress 6.0 wurde durch die Option zum
Durchfiihren von Dokumentscans fir Mammographie erganzt.
Falls Sie nicht tiber die PDI-Option verfiigen, missen Sie sie
hinzufiigen, um Dokumente auf einem Flachbett-Scanner scannen
zu konnen. AuRerdem miissen Sie ein Layout definieren, in dem
die Filmansicht (Film View) auf PAPIER (PAPER) eingestellt ist.

Legen Sie Ansichten unter Lokal | Mammeographie (Local | Mammography) in

der Baumstruktur Administration fest.

& Administration )

- Lacal
. - Dizplay Settings

x|

-~ Digitizer 53““‘9_3 —Create, Edit and Delete Marnmo Wiew Layouts
i |mage Processing

8 1 armmography - Visws

: - Mandatory Fields MHame | Layout | Digitization Order

s |Jzer Manager

- Anonynize
: - License Backup
Targets
‘-~ Film Digitizer

|

| H

Custamize | Mew |

—Yiew Order
Layout |232 'l — = = =
Row | Column | Filmiew | Patient Orientation |
— Layout Presview RELC Frosterior Left [P\
1 2 EEE Anterior Right [45\R]
2 1 RAMLO Posterior Foot Left [...
2 2 LMLO Anterior Foot Right ...
RCC LCC
RMLO LMLO
4] |
Edt | Delete |

For other changes create a new layout,

Mate : Only the Filn Wiew and the Patient Orientation in the Yiew Order can be changed when editing.

Cloze
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1. Klicken Sie auf die Schaltfliche Neu (New).

2. Klicken Sie in der Liste Ansichten (Views) in der Spalte Name, geben Sie
den Namen fiir das Layout ein und driicken Sie EINGABE.

Wiz
Marmne Layout Digitization Order
DEFAULT 22 RCC | LCC | BMLO | LMLO |
Lapout 1 v RCC | LCC | RMLO | LMLO | RML | LML |
Layout 2 1x1 Cv |
Lapout 3 2ud RCC | LCC | RMLO | LMLO | RML | LML | RMLO | LMLO |
| LMLO | AWML | LML |

Lapout 4 23 RCC | LCC | RMLO

AMLO | LMLO

3. Offnen Sie die Liste Layout und klicken Sie auf das gewiinschte Layout
Zeile x Spalte (row x column).

4. Legen Sie in der Liste Ansichtsreihenfolge (View Order) die Filmansicht
(Film View) fiir jede Zelle fest. Die Layout-Vorschau (Layout Preview)

zeigt, wie Filmansichten zu Zellen hinzugefiigt werden.

Yiew Order

Row Colurnn | Film Yiew | Patient Orientation
=T | F'ozterior Left [PL]
BEC Anterior Right [A4R]

Pozterior Foat Left [
Anterior Foot Right [...

Hinweis: Zum Scannen von Dokumenten setzen Sie
Filmansicht (Film View) auf PAPIER (PAPER).

Hinweis: Patientenausrichtung (Patient Orientation) wird
automatisch festgelegt, wenn Sie eine Filmansicht (Film View)
auswahlen, und sollte nicht geandert werden.

Hinweis: Der Benutzer kann die hier eingestellte
Standardeinstellung Patientenausrichtung (Patient
Orientation) andern.

m So Ischen Sie eine Ansicht:
a. Klicken Sie in der Liste Ansichten (Views) auf die Ansicht und klicken Sie
dann auf die Schaltfliche Loschen (Delete).
b. Bestitigen Sie die Loschung.

19746-001 Rev. C ClinicalExpress 6.1 Administratorhandbuch



Konfigurieren von ClinicalExpress 43

m S0 bearbeiten Sie eine Ansicht:

a. Klicken Sie in der Liste Ansichten (Views) auf die Ansicht und klicken Sie
dann auf die Schaltflaiche Bearbeiten (Edit).

b. Klicken Sie in der Liste Ansichten (Views), klicken Sie auf Name und
geben Sie dann einen neuen Namen ein.

c. Andern Sie ggf. in der Liste Ansichtsreihenfolge (View Order)
Filmansicht (Film View) und Patientenausrichtung (Patient Orientation).

d. Klicken Sie auf Speichern (Save).

Hinweis: Eine Ansicht kann nur dann geléscht oder bearbeitet
werden, wenn sie keinen Verweis aus einer Untersuchung enthalt.

Erlauterung der Ansichten und Patientenausrichtungen

Die folgenden Beispiele verdeutlichen die Beziehungen zwischen Ansichten,
Bildern und Patientenausrichtungen.

Angenommen, Sie definieren zwei Ansichten wie folgt:

Ansicht A
Zeile Spalte Filmansicht | Patientenausrichtung
1 1 RCC PF
1 2 LCC AF
2 1 RLMO AFL
2 2 LMLO PFL
Ansicht B
Zeile Spalte Filmansicht | Patientenausrichtung
1 1 RCC FL
1 2 LCC PF
2 1 RLMO PFL
2 2 LMLO FR

In Zellen abgelegte Bilder erhalten die standardméBigen Patientenausrichtungen.
Angenommen Ansicht A ist wirksam. Das in Zeile 1, Spalte 1 abgelegte Bild
(RCC) bekommt die Standard-PF-Ausrichtung.

Angenommen der Benutzer klickt mit der rechten Maustaste auf ein Bild, andert
die Ausrichtung zu PF und zieht das Bild dann zu Zeile 2, Spalte 2 (LMLO).
Dieses Bild tibersteuert die Standard-PFL-Ausrichtung und behélt die
benutzerseitig zugewiesene PF-Ausrichtung bei.

Angenommen der Benutzer wihlt Ansicht B fiir dieselbe Untersuchung. Bei
diesem Vorgang werden die Standard-Patientenausrichtungen von Ansicht B
auf die Bilder angewendet. Beispielsweise weist das Bild in RCC nun die
Patientenausrichtung FL auf.
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Angenommen der Benutzer schlieit die Untersuchung. AnschlieBend bearbeiten
Sie (der Administrator) Ansicht B und &ndern damit die RCC-Patientenausrichtung
zu AF. Wenn die Untersuchung neu gedffnet wird, weist das RCC-Bild die
Patientenausrichtung FL auf (wurde beim Schlie3en mit der Untersuchung
gespeichert), nicht AF (die Standard-RCC-Ausrichtung AF). Wenn jedoch ein Bild
zur RCC-Zelle hinzugefiigt wird, ist dessen Patientenausrichtung die Standard-
Ausrichtung AF.

Erstellen von benutzerdefinierten Codes und
benutzerdefinierten Ansichtsmodifizierer-Codes

Sie konnen benutzerdefinierte Ansichtscodes erstellen, die in der Dropdown-
Liste in der Spalte Filmansicht (Film View) der Liste Ansichtsreihenfolge
(View Order) unter Lokal | Mammographie (Local | Mammography) der
Baumstruktur Administration erscheinen (weiter oben in diesem Abschnitt
beschrieben). Sie konnen aullerdem benutzerdefinierte Ansichtsmodifizierer-
Codes erstellen, die mit benutzerdefinierten Ansichtscodes verbunden werden.

Hinweis: Bei Verdffentlichung dieses Handbuchs waren die
benutzerdefinierten Ansichtscodes und die benutzerdefinierten
Ansichtsmodifizierer-Codes nicht von DICOM oder IHE definiert.
Die Entwicklung, Verwendung und Zuverlassigkeit von
benutzerdefinierten Ansichtscodes und benutzerdefinierten
Ansichtsmodifizierer-Codes liegt allein in der Verantwortung des
ClinicalExpress-Benutzers.

m So erstellen Sie einen benutzerdefinierten Ansichtscode:

1. Klicken Sie unter Lokal | Mammographie (Lokal | Mammography) in der
Baumstruktur Administration auf die Schaltfliche Benutzerdefiniert
(Custom). Hierdurch wird das Fenster Mammeographie-Ansicht anpassen
(Customize Mammography View) geoftnet (sieche néchste Seite).

2. Klicken Sie im Bereich Benutzerdefinierte Ansichtscodes (Custom View
Codes) auf die Schaltfliche Neu (New).

3. Klicken Sie in den einzelnen Spalten und geben Sie die zugehorigen
Informationen ein.

4. Klicken Sie auf Speichern (Save).

m S0 bearbeiten Sie einen benutzerdefinierten Ansichtscode:
1. Klicken Sie im Bereich Benutzerdefinierte Ansichtscodes (Custom View
Codes) auf den Ansichtscode, den Sie bearbeiten mochten.
2. Klicken Sie auf Bearbeiten (Edit).
Andern Sie die Informationen nach Bedarf.
4. Klicken Sie auf Speichern (Save).

W
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So lI6schen Sie einen benutzerdefinierten Ansichtscode: Klicken Sie auf den
Ansichtscode, den Sie 16schen mochten, und klicken Sie auf Loschen (Delete).

Hinweis: Ein benutzerdefinierter Ansichtscode kann nur dann
bearbeitet oder geléscht werden, wenn er keinen Verweis aus
einer Untersuchung enthalt.

So erstellen Sie einen benutzerdefinierten Ansichtsmodifizierer-Code:

1. Klicken Sie im Bereich Benutzerdefinierte Ansichtsmodifizierer-Codes
(Custom View Modifier Codes) auf die Schaltfliche Neu (New).

2. Klicken Sie in den einzelnen Spalten und geben Sie die zugehorigen
Informationen ein.

3. Klicken Sie auf Speichern (Save).

So bearbeiten Sie einen benutzerdefinierten Ansichtsmodifizierer-Code:

1. Klicken Sie im Bereich Benutzerdefinierte Ansichtsmodifizierer-Codes
(Custom View Modifier Codes) auf den Modifizierercode, den Sie
bearbeiten mochten.

2. Klicken Sie auf Bearbeiten (Edit).

3. Andern Sie die Informationen nach Bedarf.

4. Klicken Sie auf Speichern (Save).

So l6schen Sie einen benutzerdefinierten Ansichtsmodifizierer-Code: Klicken
Sie auf den Ansichtsmodifizierer-Code, den Sie 16schen méchten, und klicken
Sie auf Léschen (Delete).

Hinweis: Ein benutzerdefinierter Ansichtsmodifizierer-Code
kann nur dann bearbeitet oder geléscht werden, wenn er keinen
Verweis von einem benutzerdefinierten Ansichtscode enthalt.

Hinweis: Beim DICOM-Speichern und -Export werden
benutzerdefinierte Ansichtscodes zur DICOM-Kopfzeile

als Ansichtscode-Sequenz (0054, 0222) hinzugeflgt. Alle
Ansichtsmodifizierer-Codes werden als Ansichtsmodifizierer-
Code-Sequenz (0054, 0220) gesendet, die Teil der
Ansichtscode-Sequenz ist.
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Customize Mammography Views

-~ Custom View Codes

<

| CodeValue | CodeMeaning | Coding Scheme Designator |

Fatient Orientation

|'iews Madifier Code

MHew |

R Ll
Rl b
RS

1D

i

5
SAMPLE

Y gl

\ o e o o [
<|

~ Cugtom View Modifier Codes

[l | }|_

| ——_ Mame
SAMPLE

I
GHi

Code Yalue

Code Meaning

== |
Edit |

Delete |

// Cancel | K I
()8

N

~Wiew Order
Fow | Caolumn | Filmiew | Patient Orientation |
1 1 RCC Fozterior Left [P4L]
1 2 LCC Anterior Right [&AR]
1 3 RLO Fosterior Fook Left [...
2 1 LkLO Anterior Foot Right |...
2 2 Rkl Fozterior Foot [P4WF)
TS| &riterior Foot [A5F)
RCCL A
LHCCL
RCChe
~ LHCCM
\ [h
ExAMF—
w
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Zuweisen obligatorischer Dateneingabefelder

Gy Administration _ x|

[=l- Local

: - Dizplay Settings
- Digitizer Settings
- Image Processing
- M ammagraph

- Anonyrmize
i . License Backup
- Targets
‘- Film Digitizer

Dateneingabefelder in den Fenstern Patienteninformationen (Patient
Information) und Untersuchungsinformationen (Study Information) kdnnen
gemil den Richtlinien Threr Organisation als Pflichtfelder zugewiesen werden
(wird durch fett dargestellte Feldnamen angegeben).

Legen Sie Pflichtfelder unter Lokal | Obligatorische Felder (Local | Mandatory
Fields) in der Baumstruktur Administration fest.

— Mandatory Fields

Drata entry fieldz in the Patient Information and Study Information windows can be designated az
mandatary [indicated in bold] in accordance with your arganization's policies.
Mate: Al DICOM mandatory fields have been included by default.

Fields | M andatan

Patient Last Mame

Patient First Name

Patient Birth Date

Acceszion Mumber

Refering Physician's Last Name
Refering Physician's First Manme
Study Description

Admitting Diagnoziz Description
Series Dezcription

Procedure Code Sequence
Body Part Examined

Seriez Date/Time

Protacal Wame

Performed Protocol Code Sequence
Other Patient 1D

[ e e e e e e o e o L |

Apply |

1. Legen Sie Pflichtfelder nach Bedarf fest:

m S0 zwingen Sie den Benutzer zum Ausfullen eines Feldes: Aktivieren Sie
das Feld in der Spalte Obligatorisch (Mandatory).

m So machen Sie ein Feld zu einem optionalen Feld: Entfernen Sie die
Aktivierung im Feld Obligatorisch (Mandatory).

2. Klicken Sie auf die Schaltfliche Anwenden (Apply).
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Verwalten von Benutzerkonten

Der Benutzermanager (User Manager) erméglicht ClinicalExpress-
Administratoren das Hinzufiigen, Andern und Loschen von Benutzerkonten.

Hinweis: Allen ClinicalExpress-Benutzern missen ,Power-
User“- Berechtigungen unter Windows 2000 oder Windows XP
zugewiesen werden.

Im Bereich Lokal | Benutzermanager (Local | User Manager) im Fenster
Administration konnen Sie Benutzerkonten hinzufiigen, dndern und entfernen.
Die Anweisungen beginnen auf der néchsten Seite.

Cx Administration > ] x|

[=l- Local
' i Dizplay Settings
- Digitizer Settings —Enroll Users, Change User Passwords and Remove Lsers
- Image Processing
- M ammography
- Mandatory Fields

' -* User Manager

- Anorymize

. License Backup
- Targets
- Filrn Drigitizer

User Mame | Full Mame Description

Add E dit FHemove

MHate: All ClinicalE xpress uzers must be azsigned Power User privileges under Windows 2000 and *Windows =P,

19746-001 Rev. C ClinicalExpress 6.1 Administratorhandbuch



Konfigurieren von ClinicalExpress 49

m So fligen Sie ein Benutzerkonto hinzu:

a. Klicken Sie auf die Schaltfliche Hinzufiigen (Add). Hierdurch wird das
Fenster Benutzerinformationen (User Information) gedffnet.

User Information

User Hame: ||

Full M ame: |

Description: |

FPazzward: |

Confirn Passward: |

| Cancel |

b. Bei einem neuen Benutzer geben Sie Benutzername (User Name) (z. B.
der Anmeldename), Vollstindiger Name (Full Name) und Beschreibung
(Description) (z. B. berufliche Position) ein. Geben Sie ein Passwort
(Password) fiir den Benutzer ein und geben Sie das Passwort erneut in
Passwort bestiitigen (Confirm Password) ein.

c. Klicken Sie auf Erstellen (Create).
m S0 andern Sie den vollstdndigen Namen, die Beschreibung oder das Passwort
eines Benutzers:

a. Klicken Sie in der Benutzerliste (user list) auf die Benutzerkonto-Zeile.

b. Klicken Sie auf die Schaltfliche Bearbeiten (Edit).

User Information

Uzer Mame: |

Full Mame:

Description: |F'rimary ClinizalE #press Operator

FPazzward: |

Confirn Passward: |

| Cancel |

c. Andern Sie die Informationen nach Bedarf.

d. Klicken Sie auf Speichern (Save).
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Hinweis: Der Anmeldename eines Benutzers (User Name) kann
nicht geandert werden. Um einen Benutzernamen zu andern,
I6schen Sie das Benutzerkonto und erstellen Sie wie oben in
diesem Abschnitt beschrieben ein neues Benutzerkonto.

Hinweis: Das Passwort des Administrators kann geandert werden,
aber der Benutzername des Administrators kann nicht geandert
werden. Bewahren Sie das Administrator-Passwort an einem

sicheren Ort auf.

m So entfernen Sie ein Benutzerkonto:
a. Klicken Sie in der Benutzerliste (user list) auf die Benutzerkonto-Zeile.
b. Klicken Sie auf Entfernen (Remove).

Hinweis: Das Administrator-Benutzerkonto kann nicht geléscht
werden.

Passworter konnen nicht wieder abgerufen werden. Wenn ein Benutzer sein
Passwort vergisst, miissen Sie das Konto des Benutzers 16schen und ein neues

Konto fiir den Benutzer erstellen.
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Auswahlen von Datenfeldern fiur die Anonymisierung

Gy Administration _ x|

[=l- Local
E Dizplay Settings
- Digitizer Settings
- Image Processing
- b ammography

- b andatory Fields

IUzer Manager
)y

.. License Backup
Targets
‘- Film Digitizer

Um die Datenschutzrechte des Patienten zu schiitzen, konnen Daten in
bestimmten Feldern anonymisiert (entfernt oder durch feste Werte ersetzt)
werden, wenn Untersuchungen an ein Ziel gesendet werden. Die urspriinglichen
in der ClinicalExpress-Datenbank gespeicherten Daten werden nicht geédndert,
wenn die Anonymisierung wihrend der Ubertragung angewendet wird.

Das Einrichtung von Daten fiir die Anonymisierung erfolgt in zwei Schritten:

1. Zuweisen von Feldern, die anonymisiert werden sollen (siehe Beschreibung in
diesem Abschnitt).

2. Aktivieren der Option Anonymisieren (Anonymize) fiir Ziele (siche
Beschreibung unter ,,.Definieren von Zielen* im néchsten Abschnitt dieses
Kapitels).

Hinzufiigen, Andern oder Entfernen anonymisierter Felder im Bereich
Lokal | Anonymisieren (Local | Anonymize) im Fenster Administration.

—Add Attributes to Anonymize Studies, pdate ¥V alues and Remove Attributes

Group | Element | N arme | Y alue ||

00010 040020 Patiert ID
0=00008  O=0030 Referring Physzician Mame
0:00028  0«0080 Ikstitution M ame:

Add E dit Remowe
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m S0 weisen Sie ein Feld flr die Anonymisierung zu:

a. Klicken Sie auf die Schaltfliche Hinzufiigen (Add). Hierdurch wird das
Fenster Anonymisierer-Element-Informationen (Anonymizer Element

Information) gedffnet.

Anomymizer, Element Information

Group:  |0x0010

Mame:

Patient Hame

Last Mame:

Element: |0x0010

Firgt Mame:

Middle Mame:

W alue: |

Cancel |

b. Offnen Sie die Liste Name, und klicken Sie in das Feld, das anonymisiert
werden soll. Die folgenden Felder kdnnen anonymisiert werden:

Patientenname
Patienten-ID
Geburtsdatum
Geschlecht
Aufnahmenummer
Untersuchungsdatum
Untersuchungszeit
Untersuchungsbeschrei-
bung

e Serienbeschreibung

Diagnose bei Einweisung

Name des liberweisenden Arztes
Einrichtung

Modalitét

Hersteller

Untersuchungs-1D
Seriennummer

Instanznummer
Konvertierungstyp

Untersuchtes Korperteil

c. Optional: Geben Sie einen Wert (Value) ein, mit dem die Patientendaten
ersetzt werden sollen. Wenn kein Wert eingegeben wird, bleibt das Feld bei

der Anonymisierung leer.

d. Klicken Sie auf OK.

m S0 bearbeiten Sie die anonymisierten Werte fur ein Feld:

a. Klicken Sie auf die Zeile fiir das Feld, das Sie d&ndern mochten.

b. Klicken Sie auf die Schaltfliche Bearbeiten (Edit).

c. Andern Sie den Wert (Value) im Fenster Anonymisierer-Element-
Informationen (Anonymizer Element Information).

d. Klicken Sie auf OK.

m So entfernen Sie die Anonymisierung fiir ein Feld:

a. Klicken Sie auf die Zeile, die entfernt werden soll.

b. Klicken Sie auf die Schaltfliche Entfernen (Remove).
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Sichern und Wiederherstellen der Lizenz

Fiir ClinicalExpress-Installationen wird Lizenzsicherung bereitgestellt. Diese
Funktion sollte kurz nach der Installation von ClinicalExpress eingerichtet
werden. Damit kdnnen Sie den Lizenzschliissel an einem sicheren Ort — z. B.
einem Netzwerkverzeichnis oder auf einem Flash-Laufwerk (USB-Stick) —
speichern, um die Lizenz im Falle eines Hardware- und Softwareproblems
wiederherstellen zu kdnnen.

Die Lizenzsicherungsdatei zeichnet die Anzahl der verbleibenden Scans und die
zeitliche Begrenzung fiir die Lizenz auf. Diese Datei wird anhand der letzten
Scan- und Zeitdaten alle 24 Stunden erneut erstellt, indem die vorherige Kopie
iiberschrieben wird (daher ist die Sicherung auf CD oder DVD nicht moglich).
Wenn ClinicalExpress nicht lauft, wenn eine Sicherung fillig wird, erfolgt die
Sicherung beim nichsten Starten der Anwendung.

Lizenz sichern

Sichern Sie die Lizenz im Bereich Lokal | Lizenzsicherung (Local | License
Backup) im Fenster Administration.

Cx Administration IL x|

- Local
: - Dizplay Settings

- Diigitizer Settings — Licenze Backup

Image Processing

- M ammography ™ Enable License Backup

- Mandatory Fields

& User Manager Backup Folder:

: Anongmize I _|
- - License Backup -
- Targets
- Filrm Digitizer Backup License |

m So sichern Sie die Lizenz:

a. Aktivieren Sie die Option Lizenzsicherung aktivieren (Enable License
Backup).

b. Klicken Sie auf die Schaltfliche Mehr _I und wihlen Sie die Stelle aus,
an der die Lizenz gespeichert werden soll.

Hinweis: Wahlen Sie keine Speicherstelle auf dem lokalen
Computer. Wahlen Sie z. B. ein Netzwerkverzeichnis oder einen
USB-Stick, der immer im Computer eingesteckt ist und nicht
beeintrachtigt wird, wenn der lokale Computer Probleme
aufweist oder ersetzt werden muss.

c. Klicken Sie auf die Schaltfliche Lizenz sichern (Backup License).
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Wiederherstellen der Lizenz

Bei einem Hardware- oder Softwareproblem mit dem Computer, auf dem
ClinicalExpress ausgefiihrt, kann VIDAR Thre Lizenz wiederherstellen, wenn
Sie die Option ,,Lizenzsicherung® (License Backup) aktiviert haben (auf der
vorherigen Seite beschrieben).

1. Starten Sie eine neue E-Mail-Nachricht.
2. Geben Sie im Adressfeld nedtech@3dsystems. com ein.

3. Machen Sie die Lizenzdatei ausfindig (weist die Erweiterung .ref auf) und
héngen Sie sie an die Nachricht an.

4. Beschreiben Sie im Hauptteil der Nachricht die Situation und bitten Sie um
die Wiederherstellung Threr Lizenz.

5. Senden Sie die Nachricht.

6. Wenn Sie eine Antwort mit der wiederhergestellten Lizenz erhalten,
installieren Sie die Lizenz wie in Schritt 2 in Abschnitt ,,E. ClinicalExpress-
Lizenzschliissel anfordern im Kapitel ,,Installieren von ClinicalExpress* in
diesem Handbuch beschrieben.

Wenn Sie keine Kopie Ihrer Lizenz bereitstellen konnen, miissen Sie eine neue
Lizenz erwerben.
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Definieren von Zielen

Administratoren kénnen Parameter fiir Ziele und Remote-Gerite einrichten,
bearbeiten und 16schen. Ein Ziel ist die Destination fiir Untersuchungen und/oder
eine Quelle fiir Modalitdt-Arbeitslisten-Daten. (Die Modalitits-Arbeitsliste kann
separat erworben werden.)

Unter Ziele (Targets) in der Baumstruktur Administration konnen Sie mit Zielen
arbeiten.

Cx Administration ] x|

El- Local
- Digplay Settings

- Digitizer Settings — Set Up, Edit and Delete Parameters for T argets and Remote Devices
: L:ﬁ:rifngéf:;;jmg i Name | Type | Diescription
g td andatory Fields
i L zer Manager

- Anorymize

- Licenze Backup

DICOMPRENT N DICOM Prirter

.. DICOM PRINT
- Filen Drigitizer

Mew Edit Delete
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Erstellen eines neuen Ziels

1. Klicken Sie auf die Schaltfliche Neu (New). Hiermit wird die Seite Neues
Ziel (New Target) angezeigt.

Target Configuration

M ame: | [ LT

IR COM STORE |

Desc: | [~ Storage Cormmitrment

[ Default Target: | J

[ Anonymize

[ Allows Lozsless Compression I asirnurn b ait Tirne: | minute(s)

Communication

AE Title: [
PDU Size: I.-_mgg—
Fesponze Timeout: ID—
Part Nurmber: ID—
Host Mame: I—

[~ Dialup

Prefis: I—
Phane Mumber: I—
Domain: I—
Lser ame: I—
Password: I—

Digitizer

[ Set Film Size Based Resolution

™ Enable Bit Depth and Fesolutian

Bit Depth: Resolution;

| Cancel Save

2. Im Bereich Ziel (Target):

Target

Mame: |

Desc.: |

[~ Default
[ Anonymize

[~ Allows Lossless Compression
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. Geben Sie den Namen fiir das Ziel ein. Dabei sollte es sich um einen

eindeutigen, kurzen Namen handeln, z. B. ,,Klinik* oder ,,Dr. Gale*.
Wihlen Sie moglichst unverwechselbare Namen.

Hinweis: Nachdem der Name eingegeben und das Ziel
gespeichert wurde, kann der Name nicht mehr geandert werden.
Um den Namen zu andern, miissen Sie das Ziel [6schen und ein
neues erstellen.

. Wihlen Sie den Zieltyp (Type). Folgende Optionen stehen zur Auswabhl:

DICOM-SPEICHER
SPEICHERUBERNAHME

VON MODALITAT AUSGEFUHRTER VERFAHRENSSCHRITT
DICOM-DRUCKER

POSTSCRIPT-DRUCKER

DICOM-CD

MODALITAT-ARBEITSLISTE

DICOM-PATIENTENANFRAGE

Hinweis: Das Feld Zieltyp (Type) steuert, welche Felder im
linken Satz der Bereiche des Fensters Neues Ziel (New Target)
geandert werden kénnen und steuert Felder, die im rechten
Bereich Konfiguration (Configuration) angezeigt werden.

. (Optional) Geben Sie eine Beschreibung (Description) fiir das Ziel ein.

. So weisen Sie dieses Ziel als Standard zu: Aktivieren Sie die Option Standard

(Default). Informationen aus dem Standardziel erscheinen im Bereich Ziel
(Target) im ClinicalExpress-Hauptfenster, wenn das Programm gestartet wird
und der Benutzer auf die Schaltflache Standard-Ziel (Default Target) klickt.

Tipp: Wenn die Workstation Untersuchungen nur an ein Ziel
senden soll oder wenn ein Ziel die meiste Zeit als Ziel dient,
legen Sie dieses Ziel als Standardwert fest.

. So anonymisieren Sie Daten, die an dieses Ziel gesendet werden: Aktivieren

Sie die Option Anonymisieren (Anonymize). Felder, die im Fenster Lokal |
Anonymisieren (Local | Anonymize) fiir die Anonymisierung ausgewahlt
sind (siehe vorigen Abschnitt ,,Auswihlen von Datenfeldern fiir die
Anonymisierung® in diesem Kapitel).

. So erlauben Sie verlustlose Baseline-JPEG-Komprimierung fiir dieses Ziel:

Aktivieren Sie Verlustlose Komprimierung zulassen (Allow Lossless
Compression).
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3. Im Bereich Kommunikation (Communication):

Communication

AE Title: r
PDU Size: ,4055—
Fesponse Timeout: ,D—
Part Nuriber: ,EI—
Host Mame: l—

[~ Dialup

Prefis: l—
Phane Murnber: l—
Domain: l—
LserMame: l—
Paszword: l—

a. Geben Sie den AE-Titel (Application Entity-Titel) des Remote-Ziels ein.
Bei der Eingabe von AE-Titeln ist die GroB3-/Kleinschreibung zu beachten.

b. Geben Sie die PDU-Grof3e (Protocol Data Unit-Grofle) in Byte ein. Dies gibt
die maximale BlockgroB3e an, die das Ziel von ClinicalExpress erhalten kann.

Hinweis: AE-Titel und PDU-GroRBe werden normalerweise vom
empfangenden Programm definiert.

c. Geben Sie die erforderliche Antwortfrist (Response Timeout) in Minuten ein.
Dieser Wert gibt an, wie lange ClinicalExpress auf eine Antwort wartet,
nachdem eine Kommunikation an das Ziel gesendet wurde. Hohes
Netzwerkverkehrsaufkommen verlangsamt den Betrieb von ClinicalExpress.
Der maximale Wert ist 5 Minuten. Um keine Frist festzulegen, geben Sie 0 ein.

d. Geben Sie die Port-Nummer der empfangenden Anwendung ein
(z. B. 104, 4000).

e. Geben Sie den Host-Namen oder die IP-Adresse der empfangenden
Anwendung ein.

f. Wenn iiber eine Einwéhlverbindung auf das Ziel zugegriffen wird,
aktivieren Sie Einwéhlen (Dial-up) und geben Sie die erforderlichen
Informationen ein.
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4. Im Bereich Digitalisierer (Digitizer) konnen Sie die standardméBige Bit-Tiefe
und Auflésung einstellen und festlegen, ob Benutzer die Standardeinstellungen
andern kénnen. Die standardméBige Bit-Tiefe betrdgt 16 und die Auflésung
betragt 570. Im Bereich Digitalisierer (Digitizer):

Digitizer
I™ Set Film Size Based Resolution
| Enable Bit Depth and Resolution

Bit Depth: Rezolution;

a. Aktivieren der Filmgrofie fir die eingestellte Auflésung: Aktivieren Sie die
Option FilmgroBen-basierte Auflosung einstellen (Set Film Size Based
Resolution).

b. Andern der standardmaRigen Bit-Tiefe und Auflésung: Aktivieren Sie die
Option Bit-Tiefe und Auflésung aktivieren (Enable Bit Depth and
Resolution) und stellen Sie Bit-Tiefe (Bit Depth) und Auflésung (Resolution)
auf die erforderlichen Werte ein. (Die verfiigbaren Werte sind vom
angeschlossenen Digitalisierer abhéngig.)

c. So aktivieren Sie die standardmaRige Bit-Tiefe und Auflésung: Aktivieren

Sie die Option Bit-Tiefe und Auflésung aktivieren (Enable Bit Depth

and Resolution), oder lassen Sie die Option aktiviert. Uberlegungen:

m Deaktivieren Sie die Option Bit-Tiefe und Auflésung aktivieren (Enable
Bit Depth and Resolution), wenn das Ziel Bilder empfangen soll, die mit
einer bestimmten Bit-Tiefe und Aufldsung erfasst wurden. Dies ist die
empfohlene Konfiguration, wenn Sie nicht die Option Filmgrof3enbasierte
Auflésung einstellen (Set Film Size Based Resolution) verwenden.

m Aktivieren Sie die Option Bit-Tiefe und Auflésung aktivieren (Enable
Bit Depth and Resolution), wenn das Ziel Bilder empfangen kann, die
bei jeder beliebigen Bit-Tiefe und Auflésung erfasst wurden, und wenn
ClinicalExpress-Benutzer in der Auswahl der entsprechenden Einstellungen
fiir die Untersuchung und das Ziel geschult sind.

Hinweis: Jede Einrichtung ist dafiir verantwortlich sicherzustellen,
dass Bit-Tiefe und Auflésung fir die Bilder und Untersuchungen
angemessen sind, fur die ClinicalExpress verwendet wird.
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5. Die Optionen im Bereich Konfiguration (Configuration) sind vom
ausgewihlten Zieltyp abhingig. Befolgen Sie die Anweisungen fiir den
ausgewihlten Zieltyp.

m Fiir den Zieltyp DICOM-SPEICHER:

Canfiguration

[ LT
|

[~ Storage Cormmitrnent

Target: | J

b amirurn ' ait Tirme: | mirte(z]

a. Wenn eine Referenztabelle fiir das Ziel verfiigbar ist, aktivieren Sie
LUT und klicken Sie dann auf die Schaltfliche ... (siche Pfeil), um die
LUT-Datei auszuwéhlen.

b. Wenn ClinicalExpress auf Speicheriibernahme-Mitteilungen von einem

Ziel reagieren soll:

e Aktivieren Sie Speicheriibernahme (Storage Commitment).

e Waihlen Sie ein Ziel aus, oder wihlen Sie fiir diese Option Gleich
(Same), um es auf das aktuelle Ziel anzuwenden.

e Geben Sie eine Maximale Wartezeit (Maximum Wait Time) ein.
ClinicalExpress wird nur aktiv, wenn innerhalb dieses Zeitraums eine
Speicheriibernahme-Bestétigung eingeht.

m Fiir den Zieltyp SPEICHERUBERNAHME:

Configuration
Storage Commitment

b amimnunn e ait Time: |':' rirute(s]

Geben Sie eine Maximale Wartezeit (Maximum Wait Time) ein.
ClinicalExpress wird nur aktiv, wenn innerhalb dieses Zeitraums eine
Speicheriibernahme-Bestétigung eingeht.

m Fiir den Zieltyp VON MODALITAT AUSGEFUHRTER
VERFAHRENSSCHRITT gibt es keine Konfigurationsoptionen.
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m Fiir den Zieltyp DICOM-DRUCKER:

Caonfiguration
Settings

Magnification: |REFLICATE = | | True Size

Film Orientation: |PORTRAIT = il ohislale

i 14:17:1916,2520
Media: CLEAR FILM - =
Filrn Size: T4N=17IN =

Diin: a
[BEEVS 1}
[ LT (
¥ Apply SDF
Printer Type Tranzformation Tppe
Tranzmizzive SCP - Create LUT and zend to
[Filrm] prinker for applying
Fieflective = SCU - Create LUT and apply on

[Paper] image before zending to printer

[ Apply SOF on image even if not supparted by the printer

[llurnination: 2000.000 cd/ m™2
&mbient Light: 10.000 cd! w2

. Wenn eine Referenztabelle fiir den Drucker verfligbar ist, aktivieren Sie

die LUT und klicken Sie dann auf die Schaltfldche ... (siche Pfeil), um

die LUT-Datei auszuwahlen. Verfligbare LUTs befinden sich im Drucker-

spezifischen Verzeichnis auf der ClinicalExpress-Installations-CD.

b. Wenn keine Referenztabelle fiir den Drucker verfligbar ist, aktivieren
Sie Standard-Display-Funktion anwenden (Apply SDF), und dann:

e Passen Sie den Druckertyp (Printer Type) an den DICOM-Drucker an.

e Setzen Sie den Transformationstyp (Transformation Type) auf SCP

(Drucker wendet SDF auf Bild an) oder SCU (ClinicalExpress wendet
SDF auf Bild an). Wenn der Transformationstyp (Transformation
Type) gelten soll, sollte der DICOM-Drucker die ,,Prasentations-LUT-
SOP-Klasse* (Presentation LUT SOP Class) unterstiitzen (fiir Details
siehe Druckerhandbuch); dies wird wiahrend der Zuweisungsphase von
der Software ausgehandelt.

Wenn SDF auch dann auf Bild anwenden, wenn dies nicht vom
Drucker unterstiitzt wird (Apply SDF on image even if not supported
by printer) aktiviert ist und der Drucker nicht die ,,Prasentations-SOP-
Klasse" unterstiitzt (im Druckerhandbuch nachschlagen), generiert
ClinicalExpress die SDF-Werte (basierend auf den Feldern
Beleuchtung (Illumination) und Umgebungslicht (Ambient Light) und
wendet eine LUT auf das Bild an, bevor es zum Drucker gesendet wird.
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Geben Sie Werte fiir Beleuchtung (Helligkeit durch Beleuchtung)
und Umgebungslicht (Helligkeit durch Umgebungslicht) ein, die
in der SDF-Berechnung verwendet werden sollen. Die DICOM-
Standardwerte lauten:

Durchlassige Medien  Reflektierende Medien
(Transmissive media) (Reflective media)

(Film) (Papier)
Beleuchtung 2000 cd/m? 150 cd/m?
(INumination)
Umgebungslicht 10 cd/m? 0 cd/m?

(Ambient Light)

c. Im Bereich Einstellungen (Settings):

Stellen Sie bei Bedarf VergroBerung (Magnification) ein. Folgende
Optionen stehen zur Auswabhl:
¢ Replizieren (Replicate) (jeder Druckerpixel représentiert einen
Bildpixel).
¢ Keine (None) (passt das Bild ohne Resampling an die
Druckergrof3e an).
¢ Bilinear (passt das Bild mithilfe von bilinearem Resampling
an die Druckergrof3e an).
¢ Kubisch (Cubic) (passt das Bild mithilfe von kubischem
Resampling an die Druckergrof3e an).
Setzen Sie Filmausrichtung (Film Orientation) auf Hochformat
(Portrait, Langskante ist vertikal) oder Querformat (Landscape,
Léangskante ist horizontal).
Waihlen Sie die Medien des Ziels aus: Blaufilm, Klarfilm oder Papier.
Legen Sie die FilmgroBie (Film Size) des Ziels in Zoll fest.
Legen Sie Mindest-Filmtransparenz (DMin) und Hochst-
Filmtransparenz (DMax) fest.
Aktivieren Sie Wahre Grofle (True Size), um das genaue
Seitenverhiltnis des urspriinglichen Films zu drucken. Falls diese
Funktion nicht aktiviert ist, wird das Seitenverhéltnis des Bildes
gedndert, damit es in den bedruckbaren Bereich passt.
Bedruckbarer Bereich (Printable Area) bezieht sich auf den
bedruckbaren Bereich, der verwendet wird, um das Bild zuzuschneiden,
wenn die angeforderte Ausgabegrofe groBer als der bedruckbare
Bereich des Druckers ist.
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Weitere Informationen tiber den bedruckbaren Bereich

Ein duplizierter Film weist gewohnlich einen kleineren Druckbereich auf als der Originalfilm mit derselben
Gesamtgrole.

m Wenn ein Bild auf Medien von derselben GroRe wie der Originalfilm gedruckt wird, ist Schrumpfen oder
Zuschneiden zu erwarten (je nach den Einstellungen im Bereich Konfiguration (Configuration) des Ziels
DICOM-DRUCKER und vom Server und Drucker bereitgestellten verfligbaren Optionen).

m Wenn ein Bild gedruckt wird, das kleiner als der bedruckbare Bereich (gewohnlich 14 x 17 Zoll) des
Druckers ist, wird das duplizierte Bild dieselbe GroRe wie das Originalbild aufweisen.

Beispiel: Angenommen der bedruckbare Bereich betragt 13,5 x 16,5 Zoll, und die Auflésung betragt 150 PPI.
Der Bedruckbare Bereich (Printable Area) betragt dann:

14X17: 2025,2475
wobei 14X17 die Originalfilmgrofe ist (muss den Grof3buchstaben ,X* aufweisen)
2025 die bedruckbare Breite in Pixel (13,5 Zoll x 150 PPI) ist
2475 die bedruckbare Lange in Pixel (16,5 Zoll x 150 PPI) ist

m Fiir den Zieltyp POSTSCRIPT-DRUCKER:

Configuration

[ LT
|

Settings

a. Wenn eine Referenztabelle fiir das Ziel verfiigbar ist, aktivieren Sie
LUT und klicken Sie dann auf die Schaltflache ... (siche Pfeil), um die
LUT-Datei auszuwahlen. Verfligbare LUTs befinden sich im Drucker-
spezifischen Verzeichnis auf der ClinicalExpress-Installations-CD.

b. Klicken Sie auf Einstellungen (Settings), um das standardméBige
Fenster Druckeinrichtung (Print Setup) zu 6ftnen. In diesem Fenster
konnen Sie einen Drucker auswéhlen und dessen Eigenschaften dndern.

Hinweis: Postscript-Druckertreiber missen installiert sein, um
diesen Zieltyp zu unterstiitzen. Informationen Gber Treiber
entnehmen Sie bitte dem Druckerhandbuch.
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m Fiir den Zieltyp DICOM-CD:

Canfiguration
DICOM CD
Copies: 1 -

Dirive: R -

a. Legen Sie die Anzahl der zu erstellenden Kopien fest.

b. Wihlen Sie das CD-Laufwerk.

m Fiir den Zieltyp MODALITAT-ARBEITSLISTE.

Caonfiguration
i apping of Wworklist Query Results
[ Use Orly Patient Information
[~ Enable Broad Query
[ Scheduled Procedure Step Start Date Ta Study Date
[ Requested Procedure 1D Tao Study 1D

a. Aktivieren Sie Nur Patienteninformationen verwenden (Use Only
Patient Information), um nur grundlegende Patienteninformationen aus
einer Modalitit-Arbeitslistenabfrage zu importieren.

b. Aktivieren Sie Breite Abfrage aktivieren (Enable Broad Query), wenn
das System auf mehrere Modalitdt-Arbeitslisten zugreifen kann und Sie
wiinschen, dass der Benutzer alle MALs mit einer einzelnen Abfrage
durchsucht.

c. Aktivieren Sie Geplantes Verfahrensschritt-Startdatum zu
Untersuchungsdatum (Scheduled Procedure Step Start Date to Study
Date), um das Verfahrensdatum einem Untersuchungsdatum zuzuordnen,
wenn Sie durch Abfrage des MAL-Servers ein neues Patientenkonto
erstellen.

d. Aktivieren Sie Angeforderte Verfahrens-ID zur Untersuchungs-ID
(Requested Procedure ID to Study ID), um eine angeforderte
Verfahrens-1D einer Untersuchungs-1D zuzuordnen.

m Fiir den Zieltyp DICOM-PATIENTENABFRAGE gibt es keine
Konfigurationsoptionen.

6. Wenn alle Zielinformationen eingegeben wurden, klicken Sie auf die
Schaltflache Speichern (Save). Das neue Ziel erscheint im Bereich Ziele
(Targets) im Fenster Administration.
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Verwalten von Zielinformationen

m So listen Sie vorhandene Ziele auf: Klicken Sie in der Administration-
Baumstruktur auf Ziele (Targets).

% Administration

Set Up, Edit and Delete Parameters for Targets and Remote Devices
DICOM Printer

PostSernipt Printer MName Type Description
Film Digitizer - :
Paper Document Scanner DICOM .F'rlnh?r DICOM _F'nnh?r
PostScript Printer PoztScript Printer

m S0 zeigen Sie die Einstellungen eines Ziels an: Klicken Sie auf den Namen des
Ziels unter Ziele (Targets) in der Administration-Baumstruktur.

m S0 bearbeiten Sie die Informationen eines Ziels:

a. Klicken Sie auf den Namen des Ziels unter Ziele (Targets) in der
Administration-Baumstruktur.
oder
Klicken Sie auf den Namen des Ziels in der Ziel-Zusammenfassungsliste.

b. Klicken Sie auf die Schaltfliche Bearbeiten (Edit). Felder werden aktiviert
und konnen bearbeitet werden.

c. Klicken Sie anschlieBend auf die Schaltfliche Speichern (Save).

m So ldschen Sie ein Ziel:

a. Klicken Sie auf den Namen des Ziels unter Ziele (Targets) in der
Administration-Baumstruktur.
oder
Klicken Sie auf den Namen des Ziels in der Ziel-Zusammenfassungsliste.

b. Klicken Sie auf die Schaltfliche Loschen (Delete).
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Uberpriifen der Kommunikation

Nachdem Sie ein Ziel definiert haben, wird empfohlen, die Kommunikation
zwischen ClinicalExpress und dem Ziel oder MAL-Broker zu tiberpriifen

(die ClinicalExpress MAL-Funktion kann separat erworben werden). Natiirlich
konnen Sie dies zu jeder beliebigen Zeit {iberpriifen.

1. Gehen Sie im ClinicalExpress-Hauptfenster zu Datei > Testmuster
generieren > SMPTE (File > Generate Test Pattern > SMPTE). Hierfiir wird
eine speziell aufgenommene Untersuchung verwendet, die ausschlieBlich zu
Testzwecken existiert.

2. Offnen Sie die Liste Ziel (Target) und klicken Sie auf das Ziel, das getestet
werden soll.

3. Klicken Sie im Bereich Ziel (Target) auf die Schaltfliche Uberpriifen
(Verify) (direkt unter der Dropdown-Liste ,,Ziel*).

4. Warten Sie, bis ClinicalExpress antwortet. Es wird eine von zwei Meldungen
angezeigt:

m ,Ziel - [Zielname]. Uberpriifungsanforderung erfolgreich” (Target — [target
name]. Verification request succeeded) bedeutet, dass das Ziel erfolgreich
auf den DICOM Echo-Befehl von ClinicalExpress geantwortet hat.

m , Ziel - [Zielname]. Uberpriifungsanforderung fehlgeschlagen” (Target —
[target name]. Verification request failed) bedeutet, dass das Ziel nicht auf
den Echo-Befehl geantwortet hat. Wenn Sie diese Meldung sehen,
iiberpriifen Sie die Zielkonfigurationsdetails in ClinicalExpress und stellen
Sie sicher, dass das Netzwerk korrekt funktioniert.

Uberpriifen der Konfiguration des Filmdigitalisierers

Betrachten Sie die Digitalisierer-Konfiguration unter Digitalisierer (Digitizer) in
der Baumstruktur Administration.

X Administration E|
= Local Film Digitizer
Display Settings -
Image Pracessing Film Diigitizer Configuration
Image Erhancement
Marnrnography Praperty Walue
Mandatary Fields Digitizer ID 1
User Manager Digitizer S erial Number 1
Ananymize g@g@tizer I';I_ardwarev\n‘er_sion i
Target igitizer Firmware Version
i Diglizer RAM Size 1024
SCSIID 1
SCEl Verzsion 1
Supported Bitz Per Pizel 8.12.16
Supported Resalutions B0, 71, 75,100, 142
Core Paszword EJB W bk
Extended Pazzword LA
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Uberpriifen der Verfiigbarkeit von ,,Modalitit-Arbeitsliste*
(Modality Work List)

Hinweis: Die ClinicalExpress-Option ,Modalitat-Arbeitsliste®
(Modality Work List) kann separat erworben werden. lhre Kopie
von ClinicalExpress muss fiir die Modalitat-Arbeitsliste lizenziert
sein, bevor diese Funktion verflgbar wird.

Hinweis: Bei der Anleitung in diesem Abschnitt wird davon
ausgegangen, dass der Administrator die Schritte zum Erstellen
eines neuen ,Modalitat-Arbeitsliste“-Ziels durchgefiihrt hat
(siehe den Abschnitt ,Definieren von Zielen* weiter oben in
diesem Kapitel).

m So stellen Sie fest, ob die Option ,,Modalitéat-Arbeitsliste* installiert ist:

a. Gehen Sie im Hauptfenster zu Ansicht > Aufgenommene
Untersuchungen (View > Acquired Studies).

b. Markieren Sie im Fenster Untersuchungsinformationen (Studies
Information) die Liste Ziele (Targets):
e Wenn die Liste mindestens ein Ziel enthilt, ist die Option ,,Modalitét-
Arbeitsliste® installiert und wurde bereits fiir ein Modalitit-Arbeitsliste-
Ziel eingerichtet.
e Wenn die Liste leer ist, ist die Option ,,Modalitit-Arbeitsliste” nicht
installiert.

c. Klicken Sie im Fenster Untersuchungsinformationen (Studies Information)
auf Schlieen (Close).
So Uberpriifen Sie, ob die ClinicalExpress-Workstation mit einer Modalitat-

Arbeitsliste-Quelle verbunden ist:

a. Offnen Sie im Hauptfenster die Liste Ziel (Target) und klicken Sie auf ein
Modalitét-Arbeitsliste-Ziel.

TARGET

| Modality work List - -]
| Werify |

b. Klicken Sie auf Uberpriifen (Verify).

c. Ein Nachrichtenfenster teilt lhnen mit, ob die Verbindung funktioniert.

Hinweis: Vollstdndige Anweisungen zur Verwendung der
Modalitat-Arbeitsliste finden Sie unter ,Importieren vorhandener
Patientendaten mithilfe der Modalitat-Arbeitsliste” im
ClinicalExpress-Bedienungshandbuch.
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Uberpriifen und Verwalten der Protokolldatei

Die Protokolldatei — eine im Programmverzeichnis gespeicherte Textdatei —
enthélt einen Datensatz der von ClinicalExpress durchgefiihrten Verfahren.
Verwenden Sie die Protokolldatei, um Benutzer- und Programmaktivititen fiir
Fehlerbehebungszwecke zu priifen und analysieren. ClinicalExpress bietet ein
Fenster zum Anzeigen und Verwalten der Protokolldatei.

|_Date/Time | Severiy | Description |
??%i%guim Information Clinical Express Launched
??%i%guim Information User Admin logged in.
??%i%guim Information Initializing Film Digitizer...
??%i%guim Information Film Digitizer error 1793.
??%i%gtzm Information |nitialized network for storage commitment event reports receiving.
??%i?gtzm Information Hot key combinations were disabled.
g;g?ﬁgugm Information Hot key combinations were enabled.
gjgg%?ugm Information Target Dicom Store of type DICOM Store created.
gjg?%gugm Information Target Modality Work List of type Modality Work List created.
Clear Log | | Refregh | |

m S0 zeigen Sie die Protokolldatei an: Ansicht > Protokolldatei (View > Log File).

m So entfernen Sie Daten aus der Protokolldatei: Klicken Sie auf die Schaltflache
Protokoll leeren (Clear Log).

m So lesen Sie neue Daten in die Protokolldatei ein: Klicken Sie auf die Schaltfldche
Aktualisieren (Refresh).

Hinweis: Legen Sie Protokolloptionen auf der Administrationsseite
Lokal (Local) fest (siehe ,,Protokoll“ im Abschnitt ,Einstellen von
lokalen Workstation-Parametern® weiter oben in diesem Kapitel).
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Kalibrieren des Filmdigitalisierers

Kalibrieren Sie den Filmdigitalisierer geméfl den Empfehlungen im Handbuch
fiir den Filmdigitalisierer.

Hinweis: Die Kalibrierung dauert mehrere Minuten; in dieser
Zeit kann der Digitalisierer oder ClinicalExpress nicht verwendet
werden.

m So kalibrieren Sie den Filmdigitalisierer:
a. Optionen > Scanner kalibrieren (Options > Calibrate Scanner).

b. Bestitigen Sie, dass Sie eine Kalibrierung initiieren mdchten.

Clinical Express

b Calibrating Digitizer: This will kake about 2 o 3 minutes,
“-‘.'p')‘ Do wou want ko conkinue?

c. Warten Sie, wihrend der Filmdigitalisierer kalibriert wird.

CALIBRATION IN PROGRESS

d. Wenn die Kalibrierung abgeschlossen ist, klicken Sie auf Ja (Yes).

Clinical Express

\!.J) Digitizer calibration successful,
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Kalibrieren lhrer Anzeige

Eine gute Bildqualitdt ist abhdngig von der richtigen Anzeigeausgabe. Wenn lhre
Anzeige ein Bild prézise darstellt, konnen Sie die Bildqualitit effektiv beurteilen
und das Bild erfolgreich optimieren. Selbst wenn der Film korrekt digitalisiert
wurde, kann das Bild den Anschein von schlechter Qualitit oder einer nicht-
kalibrierten Anzeige haben. Dieser Abschnitt beschreibt zwei Methoden zur
Kalibrierung einer Anzeige.

Melden Sie Anzeigeprobleme dem Medizintechniker, der fiir die Anzeigequalitit
verantwortlich ist. Anzeigeprobleme sollten durch griindliche Priifungen
untersucht werden. AnschlieBend sollten Anpassungen, Service, Reparatur oder
der Austausch des Gerits durchgefiihrt werden.

Fiir eine rigorosere Anzeigekalibrierung empfiehlt VIDAR die VeriLUM-
Produkte, verfiigbar von:

IMAGE Smiths, Inc.
P.O. Box 30928
Bethesda, MD 20824 USA

Telefon: +1 (240) 395-1600
Internet: www.image-smiths.com
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Kalibrieren mit dem SMPTE-Testmuster

1. Datei > Testmuster generieren > SMPTE (File > Generate Test Pattern >
SMPTE), um das SMPTE-Musterbild zu 6ffnen (unten abgebildet).

2. Minimieren Sie den Kontrast und die Helligkeit der Anzeige.
3. Erhdhen Sie die Helligkeit, bis Sie nur die Streifen in den Ecken sehen koénnen.

4. Erhohen Sie den Kontrast auf ca. 80 % oder mehr, bis Sie die 0 %/5 %- und
95 %/100 %-Quadrate auf dem Bild so deutlich wie méglich sehen.

L 111
L T

el

5% 100%

0 %/5 %-Quadrat 95 %/100 %-Quadrat

Hinweis: Wenn Sie dieses Dokument als elektronisches Dokument
auf einer Anzeige lesen und weder das 0 %/5 %-Quadrat noch

das 95 %/100 %-Quadrat auf dieser Seite (durch die Pfeile
gekennzeichnet) sehen, muss lhre Anzeige kalibriert werden.
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Kalibrieren mit dem TG18-QG-Testmuster

1. Datei > Testmuster generieren > TG18-QC (File > Generate Test Pattern >
TG18-QC), um das Musterbild TG18-QC (unten abgebildet) zu 6ffnen.

=HE
Em
M3
Al
HWE

J

El3IM

QUALITY
CONTROL

2. Fiihren Sie eine Sichtpriifung der folgenden Eigenschaften durch:

a. Geometrische Verzerrung: Uberpriifen Sie, dass die Rinder und Linien des
Musters sichtbar und gerade sind und das Muster innerhalb des aktiven
Bereichs des Anzeigegerits zentriert ist.

b. Allgemeine Bildqualitit und Artefakte: Beurteilen Sie die Gesamterscheinung
des Musters. Beachten Sie alle UnregelmiBigkeiten und Artefakte,
insbesondere an Schwarz-WeiB- und WeiB-Schwarz-Ubergiingen. Beachten
Sie, ob die Rampenbereiche ohne verzerrende Artefakte erscheinen.
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c. Luminanz, Reflexion und Storsignale: Uberpriifen, dass alle 16 Luminanz-
Patches gut sichtbar sind. Uberpriifen Sie, dass die 5 % bis 95 % Luminanz-
Patches sichtbar sind. Beurteilen Sie das Aussehen von Buchstaben mit
geringem Kontrast und bestétigen Sie die Sichtbarkeit der Ziele in den Ecken
der Luminanz-Patches.

d. Auflésung: Beurteilen Sie das Aussehen von Cx-Zielen in der Mitte oder in
den Ecken des Musters und bewerten Sie es im Vergleich mit der Referenz.
Die Ergebnisse sollten <5 fiir primére und <7 fiir sekundére Anzeigen
betragen. Uberpriifen Sie auBerdem die Sichtbarkeit der Linienpaar-Muster
bei Nyquist-Frequenz in der Mitte und in den Ecken des Musters."

Bei Fragen zum Konfigurieren der ClinicalExpress-Software
wenden Sie sich bitte an den technischen Support von VIDAR:

Telefon: +1.800.471.SCAN (+1.800.471.7226)
+1.703.471.7070 aulBerhalb der USA
E-Mail: medtech@3dsystems.com

* Die Schritte 2a bis 2d wurden mit freundlicher Genehmigung nachgedruckt aus ,,New
Developments in Display Quality Control“ von Ehsan Samei in Quality Assurance and
Quality Control in the Digital Imaging Department, Eds. E. Siegel, B. Reiner, J. Carrino,
SCAR Premier Series, Society for Computer Applications in Radiology, Great Falls, VA,
2002, S. 71-82.

19746-001 Rev. C

ClinicalExpress 6.1 Administratorhandbuch



Anmelden
Administrator, 26
Anonymisieren von Datenfeldern, 51
Anzeige
Einstellen, 17
Kalibrieren, 70
Anzeigen
Konfigurieren von Parametern, 34
Benutzerkonten, 48
Bildbearbeitungsoptionen, 38
Datenfelder
Anonym, 51
Obligatorisch, 47
Definieren von Ansichten, 41
Dokumentscanner, 15, 19
Filmdigitalisierer
Kalibrieren, 69
Konfiguration, 66
Installieren der ClinicalExpress-Software, 19
Installieren des ClinicalExpress
Filmdigitalisierers, 16
Installieren von ClinicalExpress, 14
Eingeben des Lizenzschliissels, 23
Einstellen der Anzeige, 17
Lizenzschliissel anfordern, 21
Starten, 20
Szenarien, 15
Ubersicht, 16
Konfigurieren
Anzeigeparameter, 34
Benutzerkonten, 48
Bildbearbeitungsoptionen, 38
Datenfelder fiir die Anonymisierung, 51

74

Index

Definieren von Ansichten, 41
Digitalisiererauflosungen, 37
Digitalisiererkonfiguration, 66
Filmdigitalisierer, 69
Kalibrieren der Anzeige, 70
Modalitét-Arbeitsliste (Modality Work List), 67
Obligatorische Dateneingabefelder, 47
Parameter auf der lokalen Workstation, 27
Protokolldatei, 68
Ziele, 55
Konfigurieren, 25
Lizenzschliissel
Anfordern, 21
Eingeben, 23
Sichern, 53
Wiederherstellen, 54
Modalitit-Arbeitsliste (Modality Work List)
Konfigurieren, 67
Neue Funktionen, 13
Parameter auf der lokalen Workstation, 27
Patient
Anonymisieren von Datenfeldern, 51
Protokolldatei, 68
Sichern des Lizenzschliissels, 53
System
Anforderungen, 14
Ubersicht, 9
Testmuster
SMPTE, 71
TG18-QG, 72
Wiederherstellen des Lizenzschliissels, 54
Ziele, konfigurieren, 55

19746-001 Rev. C

ClinicalExpress 6.1 Administratorhandbuch



